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Introducing Access 2007
Microsoft Office Access 2007 is a powerful relational database application that includes 
hundreds of tools that allow you to quickly start tracking, sharing, and reporting informa-
tion, even if you are new to database development. Users have access to a large library of 
professionally designed application templates, wizards that automatically create tables, 
forms, queries, and reports, and extensive local and online help resources. 

Access supports sharing data with other sources, including other programs in the 
2007 Microsoft Office system, Microsoft SQL Server, Microsoft SharePoint Products and 
Services, and documents in XML, HTML, XPS, and PDF formats. Advanced features allow 
you to create sophisticated executable database applications for use by employees and 
customers to gather and view data without their needing to know anything at all about 
database design or development.

This book gives you straightforward instructions for using Access to create databases.  
It takes you from knowing little or nothing about Access—or, for that matter, about  
databases—to a level of expertise that will enable you to create complex databases  
for use by one person or by many people.

New Features
There’s no question that Microsoft Office Access has been extensively reworked and 
improved with this version. The new Microsoft Office Fluent user interface, designed  
to make the features you need easily available when you need them, is an obvious  
indicator. But beyond the appearance and navigation, Access 2007 also has a lot of 
new and improved features that really do make this a superior program to its prede-
cessors. Because there are so many changes in this version, we don’t identify new  
features with a special margin icon (as we did in previous versions of this book). We  
do, however, list them here. Throughout this book, we include complete coverage of 
features that are new in Access 2007, including the benefits of the feature, how to use 
it, and any potential problems you might encounter.

If you’re upgrading to Access 2007 from a previous version, you’re probably more inter-
ested in the differences between the old and new versions and how they will affect you 
than you are in the basic functionality of Access. To help you identify the entire scope 
of change from the version of Access you’re familiar with, we’ve listed here the new  
features introduced in Access 2002 and Access 2003, as well as in Access 2007.
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If You Are Upgrading from Access 2003
Access 2007 has a long list of new and improved features that make it easier than ever to 
create databases to track, share, manage, and audit information. To locate information 
about a specific feature, see the index at the back of this book:

	 l	 The Ribbon.  This feature of the Office Fluent user interface organizes the most 
common commands for any database object into tabs and groups so that the 
appropriate commands are immediately accessible for the current object.

	 l	 Quick Access Toolbar.  You can customize a portion of this toolbar, displayed 
above or below the Ribbon, to include commands you regularly use, regardless of 
which Ribbon tab or database object is currently active.

	 l	 Navigation Pane.  The customizable Navigation Pane replaces the Database window 
from Access 2003. You can display or hide all tables, queries, forms, reports, macros, 
and modules, or create a custom group to display only the objects that you select. 
You can hide the Navigation Pane to make more room on the screen for your data-
base object.

	 l	 View toolbar.  This context-sensitive toolbar located in the lower-right corner of 
the program window provides single-click switching among supported views of the 
current database object, including Datasheet view, Design view, PivotTable view, 
PivotChart view, Form view, and Layout view.

	 l	 Database object display options.  Choose from Tabbed Documents, in which you 
can quickly switch between multiple database objects by clicking tabs at the top of 
the database window, and Overlapping windows that you can arrange individually 
on the screen.

	 l	 Template library.  Quickly locate and download professionally designed templates 
for common database projects.

	 l	 Improved sorting and filtering.  Easily sort all records in a table based on one  
or more fields, or filter a table or form to display or not display records matching 
multiple criteria.

	 l	 Layout view.  Redesign a form or report while viewing it.

	 l	 Stacked and Tabular layouts.  Group controls in a form or report layout so you can 
easily manipulate the entire group as one unit.

	 l	 Automatic calendar.  The date/time data type includes an optional calendar control. 
Click the calendar, and select the date you want.

	 l	 Rich Text.  Memo fields now support most common formatting options, including 
fonts, color, and character formatting. The formatting is stored with the database.
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	 l	 Create tab.  Quickly create a new table, form, query, report, macro, SharePoint list, 
or other Access object.

	 l	 Totals function.  Add a totals row to a query, and select from a list of formulas to 
automatically calculate aggregate values for forms and reports.

	 l	 Field List pane.  Drag and drop fields from one or more related or unrelated tables 
onto your active table.

	 l	 Attachment data type.  Attach photos and other files to a database record.

	 l	 Embedded macros.  Macros embedded in a form or report offer a higher level of 
security in database applications.

	 l	 Microsoft Access Help system.  Easily search built-in and online end-user and 
developer support content from within Access.

	 l	 Share information.  Easily import and export data between Access and other 
Microsoft Office applications, or XML, HTML, PDF, and dBase files; collect infor-
mation through e-mail surveys in Microsoft Office Outlook and automatically  
update your database with the responses; create or link a database with a 
SharePoint list; publish your database to a SharePoint library and allow users  
to update and extract information.

	 l	 Improved report design.  Quickly create a professional-looking report, complete 
with logo, header, and footer. Use Report view, combined with filters, to browse 
only selected records in the report.

	 l	 Group, Sort, and Total pane.  This feature makes it much easier to group and sort 
data in reports, and add totals from a drop-down list.

	 l	 Enhanced security.  Adding password protection to a database now causes Access 
to automatically encrypt the database when it closes, and decrypt it when it opens.

If You Are Upgrading from Access 2002
In addition to the features listed in the previous section, if you’re upgrading from Access 
2002 (part of the Microsoft Office XP program suite), you’ll find the following:

	 l	 Smart Tags.  Track types of data, such as dates, names, and addresses, which can 
be used in multiple ways.

	 l	 Transform.  Transform script to data when you import or export it.

	 l	 Support for Windows Theming.  Change your display theme.

	 l	 Property Update Options.  Quickly update input mask options.

	 l	 Automatic Error Checking.  Identify and correct errors in forms and reports.

	 l	 Back Up Database.  Quickly back up your database with the click of a button.
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If You Are Upgrading from Access 2000
In addition to the features listed in the previous sections, if you’re upgrading from 
Access 2000, you’ll find the following:

	 l	 Speech recognition.  Give commands and dictate text.

	 l	 Data Access Page Designer.  Efficiently design data access pages.

	 l	 Save as data access pages.  Save existing forms and reports as pages that can be 
viewed over the Web.

	 l	 Conversion error logging.  Log errors when converting Access 95, Access 97, and 
Access 2000 databases to Access 2002 file format.

	 l	 Multiple undo and redo.  Undo or redo several actions instead of just the last one.

	 l	 PivotTables and PivotCharts.  Analyze data by creating dynamic views of data.

	 l	 XML input and output.  Import XML data and publish Access data to the Web by 
exporting it in XML format.

	 l	 Stored Procedure Designer.  Create simple SQL Server stored procedures.

	 l	 Batch updating.  Save updates to records on a local computer, and send them to 
the server all at once.

	 l	 Script language support.  Set preferences for complex script languages, including 
the reading direction.

Let's Get Started!
There are so many new and improved features to this already feature-rich program that 
there are bound to be some exciting discoveries for even the most advanced users. If you 
are new to Access, you will find many automated features that let you painlessly create 
databases and add queries, forms, and professional-looking reports to track and share 
your data. We look forward to showing you around Microsoft Office Access 2007.
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Information for Readers Running 
Windows XP

The graphics and the operating system–related instructions in this book reflect the 
Windows Vista user interface. However, Windows Vista is not required; you can also use 
a computer running Windows XP.

Most of the differences you will encounter when working through the exercises in this 
book on a computer running Windows XP center around appearance rather than func-
tionality. For example, the Windows Vista Start button is round rather than rectangular 
and is labeled with the Windows Vista logo rather than the word Start; window frames 
and window-management buttons look different; and if your system supports Windows 
Aero, the window frames might be transparent. 

In this section, we provide steps for navigating to or through menus and dialog boxes in 
Windows XP that differ from those provided in the exercises in this book. For the most 
part, these differences are small enough that you will have no difficulty in completing 
the exercises.

Managing the Practice Files
The instructions given in the “Using the Companion CD” section are specific to Windows 
Vista. The only differences when installing, using, uninstalling, and removing the  
practice files supplied on the companion CD are the default installation location  
and the uninstall process.

On a computer running Windows Vista, the default installation location of the practice 
files is Documents\Microsoft Press\Access2007SBS. On a computer running Windows XP, 
the default installation location is My Documents\Microsoft Press\Access2007SBS. If your 
computer is running Windows XP, whenever an exercise tells you to navigate to your 
Documents folder, you should instead go to your My Documents folder.

To uninstall the practice files from a computer running Windows XP:

	 1.	 On the Windows taskbar, click the Start button, and then click Control Panel.

	 2.	 In Control Panel, click (or in Classic view, double-click) Add or Remove Programs.
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	 3.	 In the Add or Remove Programs window, click Microsoft Office Access 2007 Step 
by Step, and then click Remove.

	 4.	 In the Add or Remove Programs message box asking you to confirm the deletion, 
click Yes.

Important  If you need help installing or uninstalling the practice files, please see the 
“Getting Help” section later in this book. Microsoft Product Support Services does not  
provide support for this book or its companion CD.

Using the Start Menu
To start Access 2007 on a computer running Windows XP:

	 ➜	 Click the Start button, point to All Programs, click Microsoft Office, and then click 
Microsoft Office Access 2007.

Folders on the Windows Vista Start menu expand vertically. Folders on the Windows XP 
Start menu expand horizontally. You will notice this variation between the images shown 
in this book and your Start menu.
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Navigating Dialog Boxes
On a computer running Windows XP, some of the dialog boxes you will work with in the 
exercises not only look different from the graphics shown in this book but also work dif-
ferently. These dialog boxes are primarily those that act as an interface between Access 
and the operating system, including any dialog box in which you navigate to a specific 
location. For example, here are the Open dialog boxes from Access 2007 running on 
Windows Vista and Windows XP and some examples of ways to navigate in them.

Windows Vista versionWindows XP version

To navigate to the Exploring folder in Windows Vista:

	 ➜	 In the Favorite Links pane, click Documents. Then in the folder content pane,  
double-click Microsoft Press, Access2007SBS, and then Exploring.

To move back to the Access2007SBS folder in Windows Vista:

	 ➜	 In the upper-left corner of the dialog box, click the Back button.

To navigate to the Exploring folder in Windows XP:

	 ➜	 On the Places bar, click My Documents. Then in the folder content pane,  
double-click Microsoft Press, Access2007SBS, and then Exploring.

To move back to the Access2007SBS folder in Windows XP:

	 ➜	 On the toolbar, click the Up One Level button.

BackBack

Up One LevelUp One Level
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The Microsoft Business Certification 
Program

Desktop computing proficiency is becoming increasingly important in today’s business 
world. As a result, when screening, hiring, and training employees, more employers 
are relying on the objectivity and consistency of technology certification to ensure the 
competence of their workforce. As an employee or job seeker, you can use technology 
certification to prove that you already have the skills you need to succeed, saving cur-
rent and future employers the trouble and expense of training you.

The Microsoft Business Certification program is designed to assist employees in validating 
their Windows Vista skills and 2007 Microsoft Office program skills. There are two paths 
to certification:

	 l	 A Microsoft Certified Application Specialist (MCAS) is an individual who has dem-
onstrated worldwide skill standards for Windows Vista or the 2007 Microsoft Office 
suite through a certification exam in Windows Vista or in one or more of the 2007 
Microsoft Office programs, including Microsoft Office Word 2007, Microsoft Office 
Excel 2007, Microsoft Office PowerPoint 2007, Microsoft Office Outlook 2007, and 
Microsoft Office Access 2007.

	 l	 A Microsoft Certified Application Professional (MCAP) is an individual who has 
taken his or her knowledge of the 2007 Microsoft Office suite and of Microsoft 
SharePoint products and technologies to the next level and has demonstrated 
through a certification exam that he or she can use the collaborative power of the 
Office suite to accomplish job functions such as Budget Analysis and Forecasting, 
or Content Management and Collaboration.

After attaining certification, you can include the MCAS or MCAP logo with the appro-
priate certification designator on your business cards and other personal promotional 
materials. This logo attests to the fact that you are proficient in the applications or 
cross-application skills necessary to achieve the certification.
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Selecting a Certification Path
When selecting the Microsoft Business Certification path that you would like to pursue, 
you should assess the following:

	 l	 The program and program version(s) with which you are familiar

	 l	 The length of time you have used the program

	 l	 Whether you have had formal or informal training in the use of that program

Candidates for MCAS-level certification are expected to successfully complete a wide range 
of standard business tasks, such as formatting a document or spreadsheet. Successful can-
didates generally have six or more months of experience with Windows Vista or the specific 
Office program, including either formal, instructor-led training or self-study using MCAS-
approved books, guides, or interactive computer-based materials.

Candidates for MCAP-level certification are expected to successfully complete more 
complex, business-oriented tasks utilizing advanced functionality with the combined 
2007 Microsoft Office suite of products. Successful candidates generally have between 
six months and one or more years of experience with the programs, including formal, 
instructor-led training or self-study using MCAP-approved materials.

Becoming a Microsoft Certified Application 
Specialist—Microsoft Office Access 2007

Every MCAS and MCAP certification exam is developed from a set of exam skill standards 
that are derived from studies of how Windows Vista and the 2007 Office programs are 
used in the workplace. Because these skill standards dictate the scope of each exam, they 
provide you with critical information on how to prepare for certification.

To become certified as a Microsoft Certified Application Specialist for Microsoft Office 
Access 2007, you must demonstrate proficiency in these six areas:

	 l	 Structuring a database.  You must demonstrate the ability to define the appropriate 
tables, fields, and data types for a database; create, modify, and print table relation-
ships; set, change, and remove primary keys; and split a database.

	 l	 Creating and formatting database elements.  You must demonstrate the ability 
to create a database from scratch and from a template; create, modify, rename, 
summarize, and delete tables; create and modify fields and field properties;  
create and modify various types of forms and reports.
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	 l	 Entering and modifying data.  You must demonstrate the ability to enter, edit, 
delete, and move among records; find and replace data; attach documents to  
records; and import data or link to external data.

	 l	 Creating and modifying queries.  You must demonstrate the ability to create  
various types of queries based on one table or multiple tables; add tables to and 
remove tables from queries; add criteria, joins, calculated fields, and aliases; and 
create sum, average, min, max, and count queries.

	 l	 Presenting and sharing data.  You must demonstrate the ability to sort and filter 
data in tables, queries, reports, and forms; create and modify charts; export data 
from tables and queries; save database objects as other file types; and print data-
base objects.

	 l	 Managing and maintaining databases.  You must demonstrate the ability to back 
up, compact, and repair a database; encrypt a database by using a password; set 
database options and properties; identify object dependencies; print database  
information; and reset or refresh table links.

Taking a Microsoft Business Certification Exam
The MCAS and MCAP certification exams for Windows Vista and the 2007 Office  
programs are performance-based and require you to complete business-related tasks 
by using an interactive simulation (a digital model) of the Windows Vista operating  
system of one or more of the programs in the Office suite.

Test-Taking Tips
	 l	 Follow all instructions provided in each question completely and accurately.

	 l	 Enter requested information as it appears in the instructions, but without duplicating 
the formatting unless you are specifically instructed to do otherwise. For example, 
the text and values you are asked to enter might appear in the instructions in bold 
and underlined (for example, text), but you should enter the information without  
applying these formats.

	 l	 Close all dialog boxes before proceeding to the next exam question, unless you are 
specifically instructed to do otherwise.

	 l	 Don’t close task panes before proceeding to the next exam question unless, you 
are specifically instructed to do otherwise.

	 l	 If you are asked to print a document, spreadsheet, chart, report, or slide, perform 
the task, but be aware that nothing will actually be printed.
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	 l	 Don’t worry about extra keystrokes or mouse clicks. Your work is scored based 
on its result, not on the method you use to achieve that result (unless a specific 
method is indicated in the instructions), and not on the time you take to complete 
the question.

	 l	 If your computer becomes unstable during the exam (for example, if the exam 
does not respond or the mouse no longer functions) or if a power outage occurs, 
contact a testing center administrator immediately. The administrator will restart 
the computer and return the exam to the point where the interruption occurred 
with your score intact.

Certification
At the conclusion of the exam, you will receive a score report, which you can print with 
the assistance of the testing center administrator. If your score meets or exceeds the 
passing standard (the minimum required score), you will be mailed a printed certificate 
within approximately 14 days.

More Information
To learn more about the Microsoft Certified Application Specialist exams and  
courseware, visit

www.microsoft.com/learning/mcp/mcas/

To learn more about the Microsoft Certified Application Professional exams and 
courseware, visit

www.microsoft.com/learning/mcp/mcap/
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Features and Conventions of  
This Book

This book has been designed to lead you step by step through all the tasks you are most 
likely to want to perform in Microsoft Office Access 2007. If you start at the beginning and 
work your way through all the exercises, you will gain enough proficiency to be able to 
manage complex databases through Access. However, each topic is self contained. If you 
have worked with a previous version of Access, or if you completed all the exercises and 
later need help remembering how to perform a procedure, the following features of this 
book will help you locate specific information:

	 l	 Detailed table of contents.  A listing of the topics and sidebars within each 
chapter.

	 l	 Chapter thumb tabs.  Easily locate the beginning of the chapter you want.

	 l	 Topic-specific running heads.  Within a chapter, quickly locate the topic you want 
by looking at the running head of odd-numbered pages.

	 l	 Quick Reference.  General instructions for each procedure covered in specific detail 
elsewhere in the book. Refresh your memory about a task while working with your 
own documents.

	 l	 Detailed index.  Look up specific tasks and features and general concepts in the 
index, which has been carefully crafted with the reader in mind.

	 l	 Companion CD.  Contains the practice files needed for the step-by-step exercises, as 
well as a fully searchable electronic version of this book and other useful resources.

In addition, we provide a glossary of terms for those times when you need to look up 
the meaning of a word or the definition of a concept.

You can save time when you use this book by understanding how the Step by Step series 
shows special instructions, keys to press, buttons to click, and so on.
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Convention Meaning

This icon at the end of a chapter introduction indicates information 
about the practice files provided on the companion CD for use in  
the chapter.

USE This paragraph preceding a step-by-step exercise indicates the practice 
files that you will use when working through the exercise.

BE SURE TO This paragraph preceding or following an exercise indicates any require-
ments you should attend to before beginning the exercise or actions 
you should take to restore your system after completing the exercise.

OPEN This paragraph preceding a step-by-step exercise indicates files that 
you should open before beginning the exercise.

CLOSE This paragraph following a step-by-step exercise provides instructions 
for closing open files or programs before moving on to another topic.

1 
2

Blue numbered steps guide you through step-by-step exercises and 
Quick Reference versions of procedures.

1	
2

Black numbered steps guide you through procedures in sidebars and 
expository text.

➜ An arrow indicates a procedure that has only one step.

See Also These paragraphs direct you to more information about a given topic 
in this book or elsewhere.

Troubleshooting These paragraphs explain how to fix a common problem that might 
prevent you from continuing with an exercise.

Tip These paragraphs provide a helpful hint or shortcut that makes work-
ing through a task easier, or information about other available options.

Important These paragraphs point out information that you need to know to 
complete a procedure.

Save

The first time you are told to click a button in an exercise, a picture of 
the button appears in the left margin. If the name of the button does 
not appear on the button itself, the name appears under the picture.

F In step-by-step exercises, keys you must press appear as they would on 
a keyboard.

H+> A plus sign (+) between two key names means that you must hold 
down the first key while you press the second key. For example, “press 
H+>” means “hold down the H key while you press the > key.”

Program interface 
elements

In steps, the names of program elements, such as buttons, commands, 
and dialog boxes, are shown in black bold characters.

User input Anything you are supposed to type appears in blue bold characters.

Glossary terms Terms that are explained in the glossary at the end of the book are 
shown in blue italic characters.
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Using the Companion CD
The companion CD included with this book contains the practice files you’ll use as you 
work through the book’s exercises, as well as other electronic resources that will help  
you learn how to use Microsoft Office Access 2007.

What’s on the CD?
The following table lists the practice files supplied on the companion CD.

Chapter Files

Chapter 1:  
Exploring Access 2007

Exploring/Working.accdb

Exploring/Opening.accdb

Exploring/Tables.accdb

Exploring/Queries.accdb

Exploring/Forms.accdb

Exploring/Reports.accdb

Exploring/Print.accdb

Chapter 2:  
Creating a Database

Creating/TableTemplate.accdb

Creating/Manipulating.accdb

Chapter 3:  
Populating a Database

Populating/ImportAccess.accdb

Populating/Products.accdb

Populating/Customers.xlsx

Populating/ImportExcel.accdb

Populating/Employees.txt

Populating/ImportText.accdb

Populating/ImportXML.accdb

Populating/OrderDetails.xml

Populating/OrderDetails.xsd

Populating/Orders.xml

Populating/ImportHTML.accdb

Populating/NewCust.html

Populating/ImportDbase.accdb

Populating/Ship.dbf
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Chapter Files

Chapter 4:  
Sharing and Reusing Information

Sharing/ExportAccess.accdb

Sharing/Exported.accdb

Sharing/ExportExcel.accdb

Sharing/ExportWord.accdb

Sharing/ExportText.accdb

Sharing/ExportXML.accdb

Sharing/ExportHTML.accdb

Sharing/CopyOffice.accdb

Chapter 5:  
Simplifying Data Entry by  
Using Forms

Simplifying/CreateFormTool.accdb

Simplifying/RefineProperties.accdb

Simplifying/RefineLayout.accdb

Simplifying/AddControls.accdb

Simplifying/CustomersFormLogo.jpg

Simplifying/VBA.accdb

Simplifying/AftUpdate.txt

Simplifying/CreateWizard.accdb

Simplifying/AddSubform.accdb

Chapter 6:  
Locating Specific Information

Locating/SortTable.accdb

Locating/FilterTable.accdb

Locating/FilterForm.accdb

Locating/MultipleCriteria.accdb

Locating/QueryDesign.accdb

Locating/QueryWizard.accdb

Locating/Calculate.accdb

Chapter 7:  
Keeping Your Information Accurate

Accuracy/FieldTest.accdb

Accuracy/Size.accdb

Accuracy/Accurate.accdb

Accuracy/Validate.accdb

Accuracy/SimpleLookup.accdb

Accuracy/MulticolumnLookup.accdb

Accuracy/Update.accdb

Accuracy/Delete.accdb

Accuracy/Prevent.accdb
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Chapter Files

Chapter 8:  
Working with Reports

Reports/Wizard.accdb

Reports/ModifyDesign.accdb

Reports/Manually.accdb

Reports/ModifyContent.accdb

Reports/AddSubreport.accdb

Reports/Printing.accdb

Chapter 9:  
Making Your Database Easy to Use

Easy/Switchboard.accdb

Easy/CustomCategory.accdb

Easy/Features.accdb

Easy/Icon.ico

Chapter 10:  
Securing and Sharing Information

Securing/Password.accdb

Securing/Prevent.accdb

Securing/Distribute.accdb

In addition to the practice files, the CD contains some exciting resources that will really 
enhance your ability to get the most out of using this book and Access 2007, including 
the following:

	 l	 Microsoft Office Access 2007 Step by Step in eBook format

	 l	 Microsoft Computer Dictionary, Fifth Edition

	 l	 Sample chapter and poster from Look Both Ways: Help Protect Your Family on the 
Internet (Linda Criddle, 2007)

Important  The companion CD for this book does not contain the Access 2007 software. 
You should purchase and install that program before using this book.
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Minimum System Requirements

2007 Microsoft Office System
The 2007 Microsoft Office system includes the following programs:

	 l	 Microsoft Office Access 2007

	 l	 Microsoft Office Communicator 2007

	 l	 Microsoft Office Excel 2007

	 l	 Microsoft Office Groove 2007

	 l	 Microsoft Office InfoPath 2007

	 l	 Microsoft Office OneNote 2007

	 l	 Microsoft Office Outlook 2007

	 l	 Microsoft Office Outlook 2007 with Business Contact Manager

	 l	 Microsoft Office PowerPoint 2007

	 l	 Microsoft Office Publisher 2007

	 l	 Microsoft Office Word 2007

No single edition of the 2007 Office system installs all of the above programs. Specialty 
programs available separately include Microsoft Office Project 2007, Microsoft Office 
SharePoint Designer 2007, and Microsoft Office Visio 2007.

To install and run these programs, your computer needs to meet the following minimum 
requirements:

	 l	 500 megahertz (MHz) processor

	 l	 256 megabytes (MB) RAM

	 l	 CD or DVD drive

	 l	 2 gigabytes (GB) available hard disk space; a portion of this disk space will be freed 
if you select the option to delete the installation files

Tip  Hard disk requirements will vary depending on configuration; custom installation 
choices might require more or less hard disk space.

	 l	 Monitor with 800×600 screen resolution; 1024×768 or higher recommended

	 l	 Keyboard and mouse or compatible pointing device
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	 ●	 Internet connection, 128 kilobits per second (Kbps) or greater, for download and 
activation of products, accessing Microsoft Office Online and online Help topics, 
and any other Internet-dependent processes

	 ●	 Windows Vista with Service Pack 1 (SP1) or later, Microsoft Windows XP with 
Service Pack 2 (SP2), or Microsoft Windows Server 2003 or later

	 ●	 Windows Internet Explorer 7 or Microsoft Internet Explorer 6 with service packs

The 2007 Microsoft Office suites, including Office Basic 2007, Office Home & Student 2007, 
Office Standard 2007, Office Small Business 2007, Office Professional 2007, Office Ultimate 
2007, Office Professional Plus 2007, and Office Enterprise 2007, all have similar requirements.

Step-by-Step Exercises
In addition to the hardware, software, and connections required to run the 2007 Microsoft 
Office system, you will need the following to successfully complete the exercises in this book:

	 ●	 Access 2007, Excel 2007, and Outlook 2007

	 ●	 Access to a printer

	 ●	 52 MB of available hard disk space for the practice files

Installing the Practice Files
You need to install the practice files in the correct location on your hard disk drive 
before you can use them in the exercises. Follow the steps below.

Note  If for any reason you are unable to install the practice files from the CD, the files can 
also be downloaded from the Web at http://www.microsoftpressstore.com/title/9780735623033.

	 1.	 Remove the companion CD from the envelope at the back of the book, and insert it into 
the CD drive of your computer. If the AutoPlay window opens, click Run startcd.exe.

The Microsoft Software License Terms appear. To use the practice files, you must 
accept the terms of the license agreement.

	 2.	 Click I accept the agreement, and then click Next.
After you accept the license agreement, the CD interface appears.

Important  If the menu screen does not appear, click the Start button, and then click 
Computer. Display the Folders list in the Navigation Pane, click the icon for your CD 
drive, and then in the right pane, double-click the StartCD executable file.

http://www.microsoftpressstore.com/title/9780735623033
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	 3.	 Click Practice Files. If the File Download and/or Internet Explorer Security dialog 
boxes open, click Run.

	 4.	 On the Welcome page of the InstallShield Wizard, click Next. On the License 
Agreement page, click I accept the terms in the license agreement, and then 
click Next. Click Next on the first screen, and then click Next to accept the terms 
of the license agreement on the next screen.

	 5.	 If you want to install the practice files to a location other than the default folder 
(Documents\Microsoft Press\Access2007SBS), click the Change button, select the 
new drive and path, and then click OK.

Important  If you install the practice files to a location other than the default, you 
will need to substitute that path within the exercises.

	 6.	 On the Custom Setup page, click Next, and then on the Ready to Install the 
Program screen, click Install.

	 7.	 After the practice files have been installed, click Finish.
	 8.	 Close the Step by Step Companion CD window.
	 9.	 Remove the companion CD from the CD drive, and return it to the envelope at the 

back of the book.

Adding the Practice File Folder to the  
Trusted Locations List

The databases provided as practice files for this book contain macros. You can enable 
the macros in all the practice databases by adding the practice file folder to the list of 
Trusted Locations for Access 2007.

Follow these steps:

	 1.	 Click the Microsoft Office Button, and then click Access Options.
	 2.	 On the Trust Center page of the Access Options dialog box, click Trust Center 

Settings.

	 3.	 On the Trusted Locations page of the Trust Center dialog box, click Add new 
location.

	 4.	 In the Microsoft Office Trusted Location dialog box, click Browse.
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 5. In the Browse dialog box, browse to your Documents\Microsoft Press\
Access2007SBS folder, and then click OK.

 6. In the Microsoft	Offi	ce	Trusted	Location dialog box, select the Subfolders	of	
this	location	are	also	trusted check box, and then click OK in each of the open 
dialog boxes.

If you prefer to not do this, you can enable macros in an individual database by clicking 
Options in the Security Warning area that appears at the top of the content pane. In the 
Microsoft Offi ce Security Options dialog box, selecting the Enable This Content option, 
and then clicking OK.

See Also	 For	more	information	about	the	Access	2007	Trust	Center	macro	settings,	see	the	
sidebar	“Enabling	Macros	and	Other	Database	Content”	in	Chapter	1,	“Exploring	Access	2007.”

Using the Practice Files
When you install the practice fi les from the companion CD that accompanies this book, 
the fi les are stored on your hard disk in chapter-specifi c subfolders under Documents\
Microsoft Press\Access2007SBS. Each exercise is preceded by a paragraph that lists the 
fi les needed for that exercise and explains any preparations needed before you start 
working through the exercise. Here are examples:

USE the Opening database. This practice fi le is located in the Microsoft Press\Access2007SBS\
Exploring folder.

BE SURE TO start your computer, but don’t start Access before starting this exercise.

You can browse to the practice fi les in Windows Explorer by following these steps:

 1. On the Windows taskbar, click the Start button, and then click Documents.

 2. In your Documents folder, double-click Microsoft Press, double-click Access2007SBS, 
and then double-click a specifi c chapter folder.

You can browse to the practice fi les from an Access 2007 dialog box by following 
these steps:

 1. On the Favorite	Links pane in the dialog box, click Documents.

 2. In your Documents folder, double-click Microsoft Press, double-click Access2007SBS, 
and then double-click the specifi ed chapter folder.

USE the the OpeningOpening database. This practice fi le is located in the  database. This practice fi le is located in the Microsoft Press\Access2007SBS\Microsoft Press\Access2007SBS\
ExploringExploring folder. folder.

BE SURE TO start your computer, but don’t start Access before starting this exercise.start your computer, but don’t start Access before starting this exercise.

StartStart
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Removing and Uninstalling the Practice Files
After you finish working through this book, delete the practice messages, appoint-
ments, contacts, and other Outlook items you created while working through the  
exercises, and then uninstall the practice files that were installed from the companion 
CD. Follow these steps:

	 1.	 On the Windows taskbar, click the Start button, and then click Control Panel.

	 2.	 In Control Panel, under Programs, click the Uninstall a program task.

	 3.	 In the Programs and Features window, click Microsoft Office Access 2007 
Step by Step, and then on the toolbar at the top of the window, click the 
Uninstall button.

	 4.	 If the Programs and Features message box asking you to confirm the deletion 
appears, click Yes.

See Also  If you need additional help installing or uninstalling the practice files, see “Getting 
Help” later in this book.

Important Microsoft Product Support Services does not provide support for this book or 
its companion CD.

Tip  You can also view the practice files by selecting Browse on the CD menu.

Start
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Getting Help
Every effort has been made to ensure the accuracy of this book and the contents of its 
companion CD. If you do run into problems, please contact the sources listed below for 
assistance.

Errata & Book Support
If you find an error, please report it on our Microsoft Press site:

	 2.	 In the Search box, enter the book’s ISBN or title.

	 3.	 Select your book from the search results.

	 5.	 Click View/Submit Errata.

If you need additional support, please e-mail Microsoft Press Book Support at mspinput@
microsoft.com.

Getting Help with Access 2007
If your question is about Microsoft Office Access 2007, and not about the content of 
this Microsoft Press book, your first recourse is the Access Help system. This system is 
a combination of tools and files stored on your computer when you installed the 2007 
Microsoft Office system and, if your computer is connected to the Internet, information 
available from Microsoft Office Online. There are several ways to find general or specific 
Help information:

	 ●	 To find out about an item on the screen, you can display a ScreenTip. For example, 
to display a ScreenTip for a button, point to the button without clicking it. The 
ScreenTip gives the button’s name, the associated keyboard shortcut if there is one, 
and unless you specify otherwise, a description of what the button does when you 
click it.

	 ●	 In the Access program window, you can click the Microsoft Office Access Help 
button (a question mark in a blue circle) at the right end of the Ribbon to display 
the Access Help window. 

吀

1. Go to www.microsoftpressstore.com.

4. On your book’s catalog page, find the Errata & Updates tab.
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	 l	 After opening a dialog box,   you can click the Help button (also a question mark) 
at the right end of the dialog box title bar to display the Access Help window with 
topics related to the functions of that dialog box already identifi ed.

To practice getting help, you can work through the following exercise.

BE SURE TO start Access before beginning this exercise.

 1. At the right end of the Ribbon, click the  Microsoft	Offi	ce	Access	Help button.

The Access Help window opens.

 2. In  the list of topics in the Access Help window, click Activating	Access.

Access Help displays a list of topics related to activating Microsoft Offi ce system 
programs. You can click any topic to display the corresponding information.

BE SURE TO start Access before beginning this exercise.start Access before beginning this exercise.

Microsoft Offi ce 
Access Help

Microsoft Offi ce 
Access Help
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	 3.	 On the toolbar, click the Show Table of Contents button.

The Table Of Contents appears in the left pane, organized by category, like the 
table of contents in a book.

Clicking any category (represented by a book icon) displays that category’s topics 
(represented by help icons).

TopicCategory

If you’re connected to the Internet, Access displays categories, topics, and training 
available from the Office Online Web site as well as those stored on your computer.

	 4.	 In the Table of Contents, click a few categories and topics, then click the Back and 
Forward buttons to move among the topics you have already viewed.

Show Table of 
Contents

Show Table of 
Contents

	
	 Back	 Forward

	
	 Back	 Forward
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 5. At the right end of the Table	of	Contents title bar, click the Close button.

 6. At   the top of the Access	Help window, click the Type	word	to	search	for box, type 
Help	window, and then press the F key.

The Access Help window displays topics related to the words you typed.

 7. In   the results list, click Print	a	Help	topic.

The selected topic appears in the Access Help window, explaining that you can click 
the Print button on the toolbar to print any topic.

 8. Below   the title at the top of the topic, click Show	All.

Access displays any hidden auxiliary information available in the topic and changes 
the Show All button to Hide All. You can display or hide an individual item by click-
ing it. When you click the Print button, Access will print all displayed information.

CLOSE the Access Help window.

CloseClose

CLOSE the Access Help window.
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More Information
If your question is about Microsoft Office Access 2007 or another Microsoft software 
product and you cannot find the answer in the product’s Help system, please search the 
appropriate product solution center or the Microsoft Knowledge Base at:

support.microsoft.com

In the United States, Microsoft software product support issues not covered by the 
Microsoft Knowledge Base are addressed by Microsoft Product Support Services. 
Location-specific software support options are available from:

support.microsoft.com/gp/selfoverview/

We Want to Hear from You
At Microsoft Press, your satisfaction is our top priority, and your feedback our most valu-
able asset. Please tell us what you think of this book at:

http://www.microsoft.com/learning/booksurvey

The survey is short, and we read every one of your comments and ideas. Thanks in ad-
vance for your input!

Stay in Touch
Let’s keep the conversation going! We’re on Twitter: http://twitter.com/MicrosoftPress
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Quick Reference

 1 Exploring Access 2007

To open a table

 ➜ In   the Navigation Pane, expand the Tables category, and then double-click the 
table you want to open.

To access additional datasheet formatting options

 ➜ In   Datasheet view, on the Home tab, click the Font Dialog Box Launcher.

To hide the Ribbon

 ➜ Double-click   the active tab.

To display the Ribbon when it is hidden

 ➜ Click  any tab.

To unhide the Ribbon

 ➜ Double-click the active tab.

To enable macros in the current database

 1. In  the Security Warning area, click Options.

 2. In the Microsoft Offi ce Security Options dialog box, select the Enable this 
content option, and then click OK.

To add the publisher of a digitally signed database to the Trusted Publishers list

 1. In  the Security Warning area, click Options.

 2. In the Microsoft Offi ce Security Options dialog box, select the Trust all documents 
from this publisher option, and then click OK.

To add the location of this database to the Trusted Locations list

 1. In   the Microsoft Offi ce Security Options dialog box, click Open the Trust Center.

 2. In the page list in the left pane of the Trust Center, click Trusted Locations.

 3. On the Trusted Locations page, click Add new location.

 4. In the Microsoft Offi ce Trusted Location dialog box, click Browse.

 5. In the Browse dialog box, browse to the folder containing the current database, 
and then click OK.
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 6. In the Microsoft Offi ce Trusted Location dialog box, select the Subfolders of this 
location are also trusted check box if you want to do so, and then click OK in each 
of the open dialog boxes.

To change the way Access handles macros in all databases

 1. Click   the Microsoft Offi ce Button, and then click Access Options.

 2. On the Trust Center page of the Access Options dialog box, click Trust Center 
Settings.

 3. On the Macro Settings page of the Trust Center, select the option for the way you 
want Access to handle macros:

 ● Disable all macros without notifi cation. If a database contains macros, 
Access disables them and doesn’t display the security warning to give you the 
option of enabling them.

 ● Disable all macros with notifi cation. Access disables all macros and displays 
the security warning.

 ● Disable all macros except digitally signed macros. Access automatically 
enables digitally signed macros.

 ● Enable all macros. Access enables all macros.

 4. Click OK in the Trust Center and in the Access Options dialog box.

To open an existing database

 1. On   the Start menu, point to All Programs, click Microsoft Offi ce, and then click 
Microsoft Offi ce Access 2007.

 2. In the Open Recent Database list, click More, navigate to the folder in which the 
database is stored, and then double-click the database.

To close a database

 ➜ Click   the Microsoft Offi ce Button, and then click Close Database.

To view records in a table subdatasheet

 ➜ Click  the Expand button at the left end of the record.

To hide records in a subdatasheet

 ➜ Click  the Collapse button at the left end of the record.

To close a document window

 ➜ Click   the Close Window button at the right end of the document tab.

To move through a table one record at a time

 ➜ On   the record navigation bar, click the Next Record button.
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To move to a specifi c record on a datasheet

 ➜ On   the record navigation bar, select the current record number, type the number 
of the record you want, and then press F.

To switch from Datasheet View to Design View

 ➜ On   the View toolbar, click the Design View button.

To view the properties of a query

 ➜ In  the Navigation Pane, right-click the query, and then click Object Properties.

To process (or run) a query

 ➜ In   the Navigation Pane, right-click the query name, and then click Open.

To move through records in a form

 ➜ On   the record navigation bar, click the Next Record to move forward and the 
Previous Record button to move backward.

To view a form in Design view when you are currently in Form view

 ➜ On  the Home tab, in the Views group, click the View button.

To preview a report

 1. In   the Navigation Pane, right-click the report, and then click Print Preview.

 2. Click the report to display a larger view.

To view a table in Print Preview

 ➜ Click   the Microsoft Offi ce Button, point to Print, and then click Print Preview.

To change the page orientation of a table before printing

 ➜ On    the Print Preview tab, in the Page Layout group, click the Portrait button or 
the Landscape button.

To close Print Preview

 ➜ On   the Print Preview tab, click the Close Print Preview button.

 2 Creating a Database

To open a template and save it as a new database

 1. On the Getting Started with Microsoft Offi ce Access page, in the Template 
Categories list, click a category.

 2. Click the template icon for the template you want to open.

 3. In the File Name box, type a new name for the database, and note the default path.

 4. Click the Create button.
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To open a new blank database

 1. Start   Access. On the Getting Started page, click Blank Database.

 2. In the File Name box, type the name for the database.

 3. Click the Browse for a location button, browse to the folder where you want to 
save the database, click OK, and then click Create.

To enter information in a database

 ➜ Click  in an empty cell, type your text, and then press D to move to the next cell.

To change a fi eld name

 ➜ Double-click  the fi eld name, and then type the new name.

To change the data type of a fi eld

 ➜ In Design view , click in the data type cell you want to change, click the arrow that is 
displayed, and then click the data type you want to use.

To change the size of a fi eld

 1. In  Design view, click the fi eld name. 

 2. In the Field Properties area, select the current fi eld size, and then enter the new 
fi eld size.

To close and save a table or other database object

 ➜ Click     the Close button to close the table, and then click Yes to save changes.

To rename a table or other database object

 1. Close the table. In the Navigation Pane, right-click the table, and then click 
Rename.

 2. Type a new name for the table, and then press Enter.

To delete a table or other database object

 1. Close the table. In the Navigation Pane, right-click the table, and then click Delete.

 2. In the confi rmation dialog box that appears, click Yes.

To create a table by using a template

 ➜ On   the Create tab, in the Tables group, click the Table Templates button, and then 
click the type of template you want to create.

To copy a table structure to a new table

 1. Right-click the existing table in the Navigation Pane, and then click Copy. 

 2. On the Home tab, in the Clipboard group, click the Paste button. 

 3. In the Paste Table As dialog box, supply a unique name for the table, click 
Structure Only, and then click OK.
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To add a new fi eld name to a table and assign it a data type

 1. Click  in the fi rst blank Field Name cell below the existing fi eld names, type the fi eld 
name, and then press D.

 2. Click the Data Type arrow for the new fi eld, and then click the data type that you 
want assigned to the fi eld.

To delete a table row while in Design view

 ➜ Right-click   in the row you want to delete, and then click Delete Rows.

To edit a fi eld name

 ➜ Select  the part of the fi eld name you want to edit, and then type the new information.

To change the size of a table column

 1. With  the table in Datasheet View, drag the vertical bar at the right edge of a column 
header to the left or right until the column is the size you want.

 2. To size a column to the minimum width that will display all the text in that fi eld in 
all records, point to the vertical bar on the right of the column header, and when 
the pointer changes to a double-headed arrow, double-click.

To change the height of all rows in a table

 ➜ With  the table in Datasheet View, on the left side of the datasheet, drag the 
horizontal bar between any two record selectors up or down until the rows are 
the height you want.

To reset all rows in a table to standard height

 1. With  the table in Datasheet View, on the Home tab, in the Records group, click 
More, and then click Row Height to display the Row Height dialog box.

 2. In the Row Height dialog box, select the Standard Height check box or type in the 
height you want in the Row Height box, and then click OK.

To hide and unhide columns

 1. Click   anywhere in the column you want to hide, and in the Records group, click 
More. Then click Hide Columns.

 2. To restore the hidden column, click More again, and then click Unhide Columns to 
display the Unhide Columns dialog box.

 3. In the Unhide Columns dialog box, select the check box of the column you want to 
unhide, and then click Close.

To freeze and unfreeze columns

 1. Drag   through the column header of the column or columns you want to freeze.

 2. With the columns selected, click the More button, and then click Freeze.

 3. To restore the columns to their normal condition, click More, and then click Unfreeze.
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 3 Populating a Database

To import tables from one Access database into another

 1. Open    the database that you want to import to.

 2. On the External Data tab, in the Import group, click the Access button to open the 
Get External Data wizard, and then on the Select the source and destination of the 
data page, click Browse.

 3. In the File Open dialog box, navigate to the database you want to use, click it, and 
then click Open.

 4. On the Select the source and destination of the data page, with the Import tables, 
queries, forms, reports, macros, and modules into the current database option se-
lected, click OK.

 5. In the Import Objects dialog box, on the Tables tab, click Select All to select all the 
tables, or select only the tables you want to import, and then click OK to import any 
tables you selected.

To migrate a database from an earlier version of Access

 1. Open   the database, click the Microsoft Offi ce Button, point to the Save As arrow, and 
then click Access 2007 Database.

 2. In the Save As dialog box specify a name and location for the database, and click Save.

To import information from an Excel worksheet into an existing table in an Access 
database

 1. On   the External Data tab, in the Import group, click the Excel button.

 2. In the Get External Data wizard, on the Select the source and destination of the 
data page, click Browse.

 3. In the File Open dialog box, navigate to the workbook you want to use, and then 
click Open.

 4. On the Select the source and destination of the data page, select the Append a 
copy of the records to the table option, click the arrow and select the table you want 
to use in the list, and then click OK.

 5. In the Import Spreadsheet wizard, ensure your worksheet or range is selected, and 
then click Next. 

 6. If appropriate, select the First Row Contains Column Headings check box, click Next, 
and then click Finish to import the fi le.

To import a SharePoint list from a collaboration site

 1. Locate   the SharePoint site that contains the list you want to import, and make a note 
of the site address.

 2. On the SharePoint site, identify the lists you want to copy to the database, and then 
decide whether you want the entire list or just a particular view.
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 3. Review the columns in the source list or view, and identify the database into which 
you want to import the lists.

 4. On the External Data tab, in the Import group, click the SharePoint List button.

 5. On the Select the source and destination of the data page, under Specify a SharePoint 
site, click the address of the site you want to connect to, or type it in the box.

 6. Select the Import the source data or Link to the data source option, and click 
Next. Then, if prompted to do so, enter your site credentials.

 7. In the Import column, select the check box of each list you want to import into 
the database.

 8. In the Items to Import column, for each of the selected lists, select the view that 
you want to import into the database.

 9. With the Import display values instead of IDS for fi elds that look up values 
stored in another list check box selected, click OK.

 10. If you want to save the import parameters for reuse, select the Save Import Steps 
check box. On the Save Import Steps page, enter a name and description for the 
specifi cation, and then click Save Import.

To create an e-mail survey form, and then send the e-mail survey

 1. Create  a database table containing the fi elds you want to include in your survey. 
Position the insertion point in the fi rst empty record.

 2. On the External Data tab, in the Collect Data group, click the Create E-mail button.

 3. Follow the steps in the Collect Data Through E-mail Messages wizard to create the 
form, add and reorder the fi elds from the table, change fi eld labels, specify the Outlook 
folder to which the survey results will be delivered, elect to have Outlook automatically 
add replies to the original Access database table, and specify the survey recipients.

 4. Customize the text of the e-mail message that will be created, and then on the 
Create the e-mail message page, click Create. Make any changes you want to the 
message, address it to the survey recipients, and then send it.

To import information from a comma-delimited text fi le

 1. On    the External Data tab, in the Import group, click the Text File button.

 2. In the Get External Data wizard, on the Select the source and destination of the 
data page, click the Browse button, navigate to the location of the text fi le, click 
the fi le, and then click Open.

 3. Select the Append a copy of the records to the table option, and in the list, click 
the text fi le you want to use. Then click OK.

 4. In the Import Text wizard, click Next.

 5. Select or clear the check boxes you want, click Next, and click Finish to import the 
text fi le into the table. Then on the Save Import Steps page, click Close.
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To import information from an XML fi le

 1. On   the External Data tab, in the Import group, click the XML File button.

 2. On the Select the source and destination of the data page of the Get External 
Data wizard, click the Browse button, and in the File Open dialog box, navigate to 
the location of the fi le, click the one you want to use, and then click Open.

 3. On the Select the source and destination of the data page, click OK.

 4. In the Import XML dialog box, select the Structure and Data import option, and 
click OK. Then on the Save Import Steps page, click Close.

To import information from an HTML fi le into an existing table

 1. On   the External Data tab, in the Import group, click the More button, and then in 
the list, click HTML Document.

 2. On the Select the source and destination of the data page of the Get External 
Data wizard, click the Browse button, navigate to the fi le you want to use, click the 
fi le, and then click Open.

 3. Select the Append a copy of the records to the table option, click the fi le in the 
list that you want to use, and then click OK.

 4. In the Import HTML wizard, select the First Row Contains Column Headings check 
box, and then click Finish.

 5. On the Save Import Steps page, click Close.

To import information from an Outlook folder into a new table in an Access 
database

 1. On   the External Data tab, in the Import group, in the More list, click Outlook 
Folder.

 2. In the Get External Data wizard, with the Import the source data into a new 
table in the current database option selected, click OK.

 3. Expand your primary mailbox folder, click the folder you want to import, and then 
click Next.

 4. On the Field Options page, click on fi elds you don’t want to import, select the Do 
not import fi eld (Skip) check box, and then click Next.

 5. On the Primary Key page, decide whether you want to create your own key, let 
Access create the key, or have no key, and click Next. Then click Finish to import 
the contents of the folder. On the Save Import Steps page, click Close.

To import information from a dBASE fi le into an existing table in an Access 
database

 1. On   the External Data tab, in the Import group, in the More list, click dBase File. 

 2. On the Select the source and destination of the data page of the Get External 
Data wizard, navigate to the fi le you want to use, click the fi le, and then click Open.
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 3. Select the Import the source data into a new table in the current database option, 
and then click OK. On the Save Import Steps page, click Close.

To save an import operation for reuse

 ➜ Select the Save Import Steps check box, and then click Save Import. 

To run a saved import operation

 ➜ Click the Saved Imports button in the Import group on the External Data tab, click 
the import you want to run, and then click Run.

 4 Sharing and Reusing Information

To export a table from one Access database to another

 1. In   the Navigation Pane, under Tables, select the table you would like to export.

 2. On the External Data tab, in the Export group, click the More button, and then in 
the list, click Access Database.

 3. In the Export – Access Database wizard, click the Browse button. In the File Save 
dialog box, navigate to the folder you want to export to, click it, and then click Save.

 4. In the Export – Access Database wizard, click OK. In the Export dialog box, select 
the options you want, and then click OK.

 5. In the Export dialog box, with the name of the exported table showing in the 
Export to: box, and Defi nition and Data selected under Export Tables, click OK.

 6. On the Save Export Steps page, click Close.

To export a table from a database to an Excel workbook

 1. Open the table in Datasheet view. Then on the External Data tab, in the Export 
group, click the Export to Excel spreadsheet button.

 2. In the Export – Excel Spreadsheet wizard, click the Browse button. Then in the File 
Save dialog box, navigate to the folder you want to save the table in, and click Save.

 3. In the Export – Excel Spreadsheet wizard, select the Export data with formatting 
and layout check box. Then select the Open the destination fi le after the export 
operation is complete check box.

 4. With Excel Workbook selected in the File format list, click OK. On the Save Export 
Steps page, click Close.

To export the contents of a table to a SharePoint site

 1. In    the Navigation Pane, select (but don’t open) the object you want to export.

 2. On the External Data tab, in the Export group, click the SharePoint List button.

 3. In the Export – SharePoint Site wizard, specify the SharePoint site where you want 
to create the list, change the list name and type a description if you want, and then 
click OK. Enter your SharePoint site credentials if prompted to do so.
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To export a form from a database to an RTF document in Word

 1. In    the Navigation Pane, under Forms, double-click the form you want to export.

 2. On the External Data tab, in the Export group, click the Word button.

 3. In the Export – RTF File wizard, click Browse. In the File Save dialog box, navigate 
to the folder you want to save the form in, and then click Save.

 4. In the Export – RTF File wizard, select the Open the destination fi le after the export 
operation is complete check box, and then click OK.

To export a table to a text fi le with formatting

 1. Open the table in Datasheet view. Then on the External Data tab, in the Export 
group, click the Text File button.

 2. In the Export – Text File wizard, click Browse. In the File Save dialog box, navigate 
to the folder in which you want to save the fi le, and then click Save.

 3. In the Export – Text File wizard, select the Export data with formatting and layout 
check box. Then select the Open the destination fi le after the export operation is 
complete check box, and click OK.

 4. In the Encode As dialog box, select the options you want, and then click OK.

To export a table from a database to an XML fi le

 1. On    the External Data tab, in the Export group, click the More button, and then in 
the list, click XML File.

 2. In the Export – XML File wizard, click Browse, and in the File Save dialog box, 
navigate to the folder you want to store the fi le in, and click Save. 

 3. In the Export – XML File wizard, click OK.

 4. In the Export XML dialog box, with the Data (XML) and Schema of the data (XSD) 
check boxes selected, click OK. Then in the Export – XML File wizard, click Close.

To export a report from a database to an HTML fi le

 1. In    the Navigation Pane, double-click the report you want to export.

 2. On the External Data tab, in the Export group, click the More button, and then 
click HTML Document.

 3. In the Export – HTML File wizard, click Browse. Then in the File Save dialog box, 
navigate to the folder you want to save the report in, and click Save.

 4. In the Export – HTML File wizard, select the Open the destination fi le after the 
export operation is complete check box, and then click OK.

 5. In the HTML Output Options dialog box, select the encoding format options you 
want, and then click OK to export the fi le.
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To copy and paste records between an Access database table and other Offi ce 
programs

 1. Select  the records you want to copy by pointing to the row selector of the fi rst 
record you want to select, holding down the primary mouse button, and dragging 
to the last record you want to select.

 2. On the Home tab, in the Clipboard group, click the Copy button.

 3. Start the Offi ce program you want to copy to, and click where you want to paste 
the records. Then on the Home tab, in the Clipboard group, click the Paste button.

 5 Simplifying Data Entry by Using Forms

To create a form based on a table by using the Form tool

 1. Open  the table on which you want to base the form.

 2. On the Create tab, in the Forms group, click the Form button.

To move labels on a form

 ➜ Select   the labels to be moved by dragging through them, drag them to a blank 
section of the form, and then release the selection.

To change the font and font size of a label on a form

 1. Open   the form in Design View, and click the label (not its text box) you want 
to change.

 2. On the Design contextual tab, in the Font group, click the Font arrow, and then in 
the list, click the font you want to use.

 3. With the label still selected, click the Font Size arrow, and then in the list, click the 
size you want.

To edit form control properties by using the Property Sheet pane

 1. Open   the form in Design view, and if the Property Sheet pane is not visible, 
right-click the desired control, and then click Properties.

 2. In the Property Sheet pane, click the property you want to change, and either type 
the new value, or click the down arrow and select the value you want. Repeat for all 
properties that you want to change.

To edit multiple form control properties at once

 1. Click  anywhere in the Detail section of the form, and then drag diagonally to draw 
a rectangle through some portion of all the controls to select them.

 2. In the Property Sheet pane, click the property you want to change, click the arrow 
that appears, and then click the option you want. Repeat for all properties that you 
want to change.
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To set the background properties of all controls on a form

 1. Select  all the controls on the form. Then on the Format tab of the Property Sheet 
pane, click Back Style, and set it to the option you want.

 2. Click Back Color, and then click the ellipsis button.

 3. In the Color Builder, click the square of the color you want.

 4. Set the Special Effect property to the option you want, and the Border Color 
property to the color you want.

To edit the caption of a form control

 ➜ Click  the label whose caption you want to change. Then in the Property Sheet pane, 
click the Caption property, change the text to what you want, and press F.

To change the layout of controls on a form

 ➜ Drag  through all the controls on the form to select them. Then on the Arrange tab, 
in the Control Layout group, click the Remove button.

To delete a form control label

 ➜ Click   the label you want to delete, and then press the A key.

To select specifi c control labels on a form

 ➜ Hold   down the G key as you click each control or drag through just the labels 
you want to select.

To align form controls

 ➜ Select   the labels (but not their corresponding text boxes), and then in the Property 
Sheet pane, set the Text Align property to the alignment you want.

To size form control labels to fi t their contents

 ➜ Select   the labels to be sized, and then on the Arrange contextual tab, in the Size 
group, click the Size To Fit button.

To insert space between form control labels and text boxes

 ➜ Select  all the text boxes (but not their corresponding labels). Then in the Property 
Sheet pane, click the Left property, and then change the setting to the amount of 
space you want.

To bind selected controls together

 ➜ On the Arrange tab, in the Control Layout group, click the Group button.

To save the design of a form

 ➜ On   the Quick Access Toolbar, click the Save button.
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To expand the Detail area of a form

 ➜ Point  to the right edge of the form Detail grid, and when the pointer changes to a 
double-headed arrow, drag the edge of the background to the right.

To move a label or text box control on a form

 ➜ Click  a label or text box, move the pointer over its border, and when the pointer 
changes to a four-way arrow, drag it to a new location.

To create an AutoFormat form template

 1. On   the Arrange contextual tab, in the AutoFormat group, click the AutoFormat button.

 2. At the bottom of the AutoFormat gallery, click AutoFormat Wizard.

 3. In the AutoFormat dialog box, click the Customize button.

 4. In the Customize AutoFormat dialog box, click Create a new AutoFormat based 
on the Form option, and then click OK.

 5. In the New Style Name dialog box, type a name for the new style, and then click OK.

 6. Click OK to close the AutoFormat wizard. Then click the Save button, and close 
the form.

To add a graphic to a form control

 1. In   the Navigation Pane, under Forms, right-click the form you want to use, and 
then click Design View.

 2. On the Design contextual tab, in the Controls group, click the Image button, and 
then click the area where you want to place the image, drag diagonally to draw a 
rectangle, and release the mouse button.

 3. In the Insert Picture dialog box, navigate to the folder where the graphic you want 
to use is located, and then double-click the graphic.

To add a caption below a picture

 1. In  the Controls group, click the Label button, and then drag diagonally to draw a 
rectangle where you want it to appear.

 2. In the active label control, type the caption text, and then press F.

To size a label control to fi t the text

 ➜ Click  the label control, and then on the Arrange tab, in the Size group, click the 
Size to Fit button.

To add a combo box control without using a wizard

 1. On   the Design tab, in the Controls group, look at the Use Control Wizards button. 
If the button is active (orange), click it to deactivate it.

 2. In the Controls group, click the Combo Box button, and then drag diagonally in 
the form to draw a rectangle where you want the combo box to appear.
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To dynamically size a selected form control to fi t the window

 1. On the Arrange tab, in the Size group, click the Anchoring tool.

 2. In the Anchoring gallery, click Stretch Across Top.

To copy the formatting of one control to another

 ➜ Click   the box whose formatting you want to copy, and in the Font group, click the 
Format Painter button. Then click the box to which you want to apply the formatting.

To add conditional formatting to a selected control

 1. On the Design tab, in the Font group, click the Conditional button. 

 2. In the Conditional Formatting dialog box, select the criteria and the formatting 
you want to apply when the associated content meets the criteria.

To remove the record selector and scroll bar controls from a form

 1. In     Design view, click the Form selector (the box at the junction of the horizontal 
and vertical rulers), and then press $ to display the Property Sheet pane for the 
entire form (if the sheet is not already displayed).

 2. On the Format tab, change Record Selectors to No, and Scroll Bars to Neither.

To create a form based on the fi elds in a table by using the Form wizard

 1. In  the Navigation Pane, under Tables, click the table in which you want to create 
the AutoForm.

 2. On the Create tab, in the Forms group, click the More Forms button, and then in 
the list, click Form Wizard.

 3. With the open table selected in the Tables/Queries list, click the Move All button 
to move all the table fi elds to the Selected Fields list, and then click Next.

 4. On the second page of the wizard, choose the layout of the fi elds in the new 
form. On the third page, select a style option.

 5. On the fourth page, with the Open the form to view or enter information option 
selected, click Finish.

To create a form and subform simultaneously

 1. On   the Create tab, in the Forms group, click the More Forms button, and then 
click Form Wizard.

 2. On the fi rst page of the Form wizard, in the Tables/Queries list, click the table on 
which you want to base the form. Then click the Move All button to include all the 
table fi elds in the new form.

 3. To create the subform, display the Tables/Queries list, and then click the table on 
which you want to base the subform.

 4. In the Available Fields list, double-click the fi elds you want to include in the subform 
to move them to the Selected fi elds list, and then click Next.

 5. With your primary table and Form with subform(s) selected, click Next.
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 6. With Datasheet selected, click Next.

 7. On the last page of the wizard, select a style, and then click Finish.

To add a subform to a form

 1. Open  the form in Design view. Then on the Design tab, in the Controls group, 
make sure the Use Control Wizards button is active (orange).

 2. In the Controls group, click the Subform/Subreport button, and then drag 
diagonally to draw a rectangle in a section where you want to put the subform.

 3. On the Subform wizard’s fi rst page, with the Use existing Tables and Queries 
option selected, click Next.

 4. In the Tables/Queries list, click the type of item you want to use.

 5. Add fi elds to the Selected Fields list by double-clicking each fi eld. Then click Next, 
select the options you want, and click Finish.

 6 Locating Specifi c Information
To sort information in one column

 ● Click   the arrow at the right side of the column header for the column you want to 
sort, and then click the direction you want to sort the information.

 ● Click the header of the column you want to sort, and then on the Home tab, in the 
Sort and Filter group, click the Ascending or Descending button.

To sort information in multiple columns

 ➜ Select the adjacent columns you want to sort  , right-click the column header area of 
your selection, and then click how you want to sort the columns.

To move a fi eld

 ➜ Click  the column head you want to move, and then drag it to the position you want.

To fi lter records by a single criterion

 1. In the fi eld, click any instance of the record you want to fi lter by.

 2. On the Home tab, in the Sort & Filter group, click the Selection button, and then 
in the list, click Equals “[the term you want to fi lter on]”.

To remove a fi lter

 ➜ In  the Sort & Filter group, click the Toggle Filter button.

To fi lter records with a text fi lter

 1. Click  the column header arrow, point to Text Filters, and then click the criterion 
you want to fi lter by.

 2. In the Custom Filter dialog box, in the ItemText begins with box, type the fi rst few 
letters of the text you want to fi lter by. Then click OK.
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To fi lter records with a “does not equal” fi lter

 ➜ In   the column, right-click any instance of the criterion you don’t want to fi lter, and 
then click Does Not Equal “[the item you don’t want to fi lter]”.

To use the Filter By Form command

 1. In  the Navigation Pane, under Forms, double-click the form you want to search.

 2. On the Home tab, in the Sort & Filter group, click the Advanced button, and then 
in the list, click Filter By Form.

 3. Click the box you want to search in, type the search criterion, and then press F.

 4. In the Sort and Filter group, click the Toggle Filter button.

To use the Advanced Filter/Sort command to sort tables

 1. On  the Home tab, in the Sort & Filter group, click the Advanced Filter Options 
button, and then in the list, click Advanced Filter/Sort.

 2. In the fi eld list, double-click a fi eld to copy it to the fi rst cell in the fi rst column of 
the design grid.

 3. In the Criteria cell under the fi eld you just copied, type the search criterion, and 
then press F.

 4. Repeat Steps 2 and 3 for any other fi elds you want to fi lter on.

 5. In the Sort & Filter group, click the  Toggle Filter button to view the records that 
match the criteria.

To create a query in Design view

 1. On  the Create tab, in the Other group, click the Query Design button.

 2. In  the Show Table dialog box, on the Tables tab, double-click any tables you want 
to add to the query window. Then close the dialog box.

 3. Drag   the fi elds to be used in the query from the fi eld lists to consecutive columns 
in the design grid.

 4. On   the Design contextual tab, in the Results group, click the Run button to run the 
query and display the results in Datasheet view.

To save a fi lter as a query:

 1. On the Home tab, in the Sort & Filter group, click the Advanced button and then 
click Save As Query.

 2. In the Save As Query dialog box, give the query and appropriate name, and then 
click OK.

To add data to a query in Design view

 ● To add a fi eld from an existing table, double-click it.

 ● To add a fi eld from another table, drag the table from the Navigation Pane into the 
upper section of the design window, and then double-click the fi eld you want to add.
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To remove data from a query in Design view

 ● To delete a fi eld from a query, select the fi eld in the lower section of the design 
window, and then press the Delete key.

 ● To delete a table from a query, right-click the table in the upper section of the design 
window, and then click Remove Table.

To add a Totals row to a query in Datasheet view

 ➜ On the Home tab, in the Records group, click the Totals button. Then click in each 
cell of the Totals row that appears at the end of the table, and select the summary 
data you want to appear in that cell.

 7 Keeping Your Information Accurate
To set the data type for a fi eld in Design view

 1. Click  the Data Type cell next to the desired fi eld.

 2. Click the Data Type arrow, and then in the list, click the data type you want.

To view the properties of a fi eld

 ➜ With  the table in Design view, click the fi eld name to display its properties in the 
Field Properties area.

To set the Field Size property for text, number, and autonumber fi elds

 ➜ With    the table in Design view, click any cell in a fi eld, and then in the Field 
Properties area, change the Field Size property to what you want.

To use the Input Mask wizard in Design view

 1. Select  a fi eld, and then click Input Mask in the Field Properties area.

 2. Click the ellipsis button to the right of the cell to start the Input Mask wizard. 
(Click Yes if Access prompts you to install this feature.)

 3. Select an available mask in the Input Mask list, and then click Next.

 4. In the Input Mask and Placeholder character boxes, make any changes you want, 
and then click Next.

 5. Choose whether to store the data with the symbols, and then click Finish.

 6. Press F to accept the mask. Then save your changes.

To set a fi eld validation rule in Design view

 1. Select  a fi eld, and then click in the Validation Rule box in the Field Properties area.

 2. Type an expression in the Validation Rule box, or click the ellipsis button to use the 
Expression Builder.

 3. Press F. Then save the table.

To test the validation rules in a table in Design view

 ➜ Right-click  the table’s title bar, and click Test Validation Rules.
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To select an entire fi eld

 ➜ Move   the pointer to the left end of a fi eld, and when the pointer changes to a thick 
cross, click the fi eld.

To set a table validation rule

 1. Right-click  in the table window, and then click Properties.

 2. Click in the Validation Rule box, type the information for the rule, press F, and 
then save the table.

To create a lookup list with the Lookup wizard

 1. Set  the data type of a fi eld to Lookup Wizard.

 2. Select the options you want, and then click Next.

 3. Continue selecting the options you want, clicking Next when you are done with 
each page. When you are done fi lling out the wizard, click Finish.

 4. On the Quick Access Toolbar, click the Save button.

To restrict what can be entered in a lookup list

 1. In  Design view, in the Field Properties area, click the Lookup tab.

 2. Change Limit To List to Yes.

 3. Change Allow Value List Edits to No.

 4. Save the table.

To create a multi-column lookup list

 1. Add  a new fi eld, name it, and then set the data type to Lookup Wizard.

 2. Select the values option you want, and then click Next.

 3. Type the number of columns you want, and then enter the data you want in each 
column.

 4. Click Next, and then click Finish.

 5. Save your changes.

To prevent a column from being displayed in a multi-column lookup list

 ➜ In  Design view, on the Lookup tab, in the Column Widths box, change the width 
for the column you don’t want displayed to 0. Then save your changes.

To fi lter selections in a multi-column lookup list

 1. Right-click  any cell in a column you want to fi lter, point to Text Filters, and then 
click the fi lter option you want.

 2. In the Custom Filter box, type criterion you want to fi lter for, and then press F.

To create a select query

 1. You  must fi rst create a select query. On the Create tab, in the Other group, click 
the Query Design button.



 Quick Reference  lvii

 2. In the New Query dialog box, with Simple Query Wizard selected, click OK.

 3. In the Tables/Queries list, click the option you want. Then in the Available Fields 
list, double-click the fi elds you want to move to the Selected Fields list.

 4. In the Simple Query Wizard dialog box, click Finish to create the select query.

To create an update query

 1. First, create a select query that selects the records you want to update.

 2. Open the select query in Design view. Then on the Design contextual tab, in the 
Query Type group, click the Update button.

 3. In the design grid, type the expression for your update.

To create an action query

 1. First, create a select query that selects the records you want to manipulate.

 2. Open the select query in Design view. Then on the Design contextual tab, in the 
Query Type group, click the Make Table, Append, Update, or Delete button.

 3. Provide the information requested for the specifi ed query type.

To create a delete query

 1. First, create a select query that selects the records you want to delete.

 2. Open the select query in Design view. Then on the Design contextual tab, in 
the Query Type group, click the Delete button to convert this select query to 
a delete query.

 3. In the design grid, set the delete criteria.

To back up a database

 1. Click   the Microsoft Offi ce Button, point to Manage, and then click Back Up 
Database.

 2. In the Save As dialog box, navigate to the folder in which you want to store the 
backup, and then click Save.

To compact a database

 ➜ Click   the Microsoft Offi ce Button, point to Manage, and then click Compact and 
Repair Database. Acknowledge the safety warning if prompted to do so.

To analyze the performance of a database

 1. On  the Database Tools tab, in the Analyze group, click the Analyze Performance 
button.

 2. In the Performance Analyzer dialog box, on the All Object Types tab, click Select 
All, and then click OK.

 3. Click each result in the Analysis Results box to display more information about that 
result in the Analysis Notes area.
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To document a database

 1. On   the Database Tools tab, in the Analyze group, click the Database Documenter 
button.

 2. In the Documenter dialog box, select the options you want on each tab. Then click 
OK to start the documentation process.

 8 Working with Reports
To create a report by using the Report wizard

 1. On   the Create tab, in the Reports group, click the Report Wizard button.

 2. On the fi eld selection page, click the Tables/Queries arrow, and then in the list, 
click the table or query that you want to base your report on.

 3. In the Available Fields list, double-click the fi elds you want to move to the 
Selected Fields list.

 4. To select fi elds from additional tables or queries, repeat Steps 2 and 3.

 5. On the fi eld selection page, click Next.

 6. On the grouping page, select how you want to view your data, and then click Next.

 7. On the grouping levels page, add up to four grouping levels by double-clicking 
fi eld names to move them to the top of the preview pane. Then click the Grouping 
Options button.

 8. In the Grouping Intervals dialog box, click the Grouping intervals arrow next to 
each grouping level and select the desired interval, click OK, and then click Next.

 9. On the sort order page, click the arrow to the right of the fi rst box, and select a 
fi eld to sort on; repeat for each fi eld you want to sort on, and then click Next.

 10. On the layout page, select the options you want, and then click Next.

 11. On the style selection page, click the style you want, and then click Next.

 12. In the title box, type a title for the report, and then with the Preview the report 
option selected, click Finish.

To preview a print version of a report

 ➜ In   the Navigation Pane, right-click the desired report, and then click Print Preview.

To adjust the height of a report section

 1. In  the Navigation Pane, right-click the desired report, and then click Design View.

 2. Point to the top edge of a section selector. 

 3. When the pointer changes to a two-headed vertical arrow, drag the selector in the 
direction you want.

To insert the current date in a report

 1. In   Design view, on the Design contextual tab, in the Controls group, click the 
Date & Time button.
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 2.  In the Date And Time dialog box, select a date format option, and clear the 
Include Time check box if you want to include only the date. Then click OK.

To reposition a text box in a report

 ➜ In   Design view, select the text box, then drag it to the desired location.

To align text in a report

 ➜ In    Design view, select the text box, and in the Font group, click one of the 
alignment buttons.

To delete a text box from a report

 ➜ In    Design view, click the text box to select it, and then press A.

To move controls as a group

 1. In  Design view, drag diagonally to draw a rectangle through some portion of all the 
labels and the text boxes you want to move.

 2. Drag the selected controls to where you want them.

To change the page width of a report

 1. In  Design view, click the Report Selector. Then press $ to display the Property 
Sheet pane.

 2. On the Format tab, change the Width setting.

To group and sort data in a report

 1. Switch    to Design view. 

 2. On the Design tab, in the Grouping & Totals group, click the Group & Sort button.

 3. In the Group, Sort, and Total pane, in the Group on bar, click More to see additional 
options, and then choose the ones you want. 

 4. Click the Group & Sort button to close the Group, Sort, and Total pane.

To insert a horizontal line in a report

 1. In   Design view, in the Controls group, click the Line button.

 2. Click the location where you want the horizontal line to appear.

 3. Press $ to display the Property Sheet pane. Then set the Left, Width, and Border 
Color properties as desired.

To align the columns of a report

 1. In   Design view, select the label and text box for the column you want to align.

 2. Press $ to display the Property Sheet pane. Then set the Left and Width properties 
to precisely align the column on the page.

 3. Repeat Step 2 for each column you want to align.
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To change the Design view grid for a report

 1. In  Design view, click the Report selector, and then press $ to open the Property 
Sheet pane.

 2. On the Format tab, change the Grid X and Grid Y properties to the number of dots 
per inch that you want to show on the grid.

To set the height of a section in a report

 ➜ Click  the section, and on the Format tab in the Property Sheet pane, set the 
Height property to the measurements you want.

To save a new report

 1. On   the Quick Access Toolbar, click the Save button. 

 2. In the Save As dialog box, type a name for the new report in the Report Name 
box, and then click OK.

To insert a title in a report

 ➜ Open  the report in Design view. Then on the Design contextual tab, in the 
Controls group, click the Title button.

To insert a page number in a report

 1. Open   the report in Design view. Then in the Controls group, click the Insert Page 
Number button. 

 2. In the Page Numbers dialog box, select the desired format, position, and alignment 
options. Then click OK.

To insert a subreport in a report

 1. Open  the main report in Design view. Then double-click the Report Selector to 
display the Property Sheet pane.

 2. On the Data tab, click the Record Source arrow, and select the table or query on 
which the subreport will be based.

 3. On the Design contextual tab, in the Controls group, click the Subform/Subreport 
button, and then click a point on the main report.

 4. In the Subreport wizard, with the Use existing Tables and Queries option selected, 
click Next.

 5. In the Tables/Queries list, click the query you want to use.

 6. In the Available Fields list, double-click the fi elds you want to use to move them to 
the Selected Fields list, and then click Next.

 7. Select the appropriate options to defi ne the fi elds you want to include in the 
subform.

 8. Click Next, and then click Finish.
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To view a report in Print Preview mode

 ● If   the report is not open, right-click it in the Navigation Pane, and then click Print 
Preview.

 ● If the report is open, on the Home tab, in the Views group, click the View arrow, 
and then click Print Preview, or click the Print Preview button on the View toolbar.

To view a report in Layout View mode

 ● If   the report is not open, right-click it in the Navigation Pane, then click Layout View.

 ● If the report is open, on the Home tab, in the Views group, click the View arrow, 
and then click Layout View, or click the Layout View button on the View toolbar.

To print a report

 1. Either   open the report or select it in the Navigation Pane.

 2. Click the Microsoft Offi ce Button, and then click Print.

 3. In the Print dialog box, set the properties you want, and then click OK.

 9 Making Your Database Easy to Use

To create a switchboard

 1. On  the Database Tools tab, in the Database Tools group, click the Switchboard 
Manager button, and then click Yes if Access asks whether you want to create a 
switchboard.

 2. With Main Switchboard (Default) selected in the Switchboard Pages list, click Edit. 

 3. In the Switchboard Name box, replace Main Switchboard with a name for your 
switchboard. Then click Close.

To add a new page to a switchboard

 1. On  the Database Tools tab, in the Database Tools group, click the Switchboard 
Manager button.

 2. In the Switchboard Manager window, select the type of switchboard you want, 
and then click New.

 3. Replace the default new switchboard page name with the name you want, and 
then click OK.

To create a button on a switchboard page

 1. On   the Database Tools tab, in the Database Tools group, click the Switchboard 
Manager button.

 2. With the switchboard selected in the Switchboard Pages list, click Edit.

 3. In the Edit Switchboard Page window, click New.
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 4. In the Edit Switchboard Item dialog box, in the Text box, type a name for the 
button label.

 5. If you want to change the command assigned to the button, click the Command 
arrow, and then click your selection in the list.

 6. If there is a box below the Command box, click the arrow next to it, and in the list, 
select the appropriate option. Then click OK.

 7. In the Edit Switchboard Item dialog box, click OK.

To create a custom category

 1. Right-click  the category header at the top of the Navigation Pane, and then click 
Navigation Options.

 2. In the Grouping Options area of the Navigation Options dialog box, click the Add 
Item button.

 3. Replace the default name of the new category with the name you want, and then 
press F.

 4. Click the Add Group button, and then in the Groups list, replace Custom Group 1 
with the new group name.

 5. In the Navigation Options dialog box, click OK.

To add shortcuts to a category

 1. Click   the category header at the top of the Navigation Pane, and then click the 
custom category that you want to add shortcuts to.

 2. In the Unassigned Objects group, click the object you want to add to a custom 
group, and drag the object on top of the desired group header to add a shortcut 
to the group; or right-click the desired object, point to Add to group, and click the 
group you want to add the shortcut to.

To add any command to the Quick Access Toolbar

 1. At  the right end of the Quick Access Toolbar, click the Customize Quick Access 
Toolbar button.

 2. Near the bottom of the Customize Quick Access Toolbar menu, click More 
Commands.

 3. In the Access Options window, click the Choose commands from arrow, and in the 
list, click the area from which you want to add a command.

 4. In the available commands list, locate and click the command you want to add to 
the Quick Access Toolbar. Then between the two command lists, click Add.

 5. At the bottom of the Customize page, click OK.
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To reposition commands on the Quick Access Toolbar

 1. On  the Customize page of the Access Options window, click the command you 
want to move, and then click the Move Up or the Move Down button until the 
command is in the position you want.

 2. At the bottom of the Customize page, click OK.

To add a command from the Ribbon to the Quick Access Toolbar

 ➜ Right-click   the command on the Ribbon, and then click Add to Quick Access 
Toolbar.

To remove a command from the Quick Access Toolbar

 1. At   the right end of the Quick Access Toolbar, click the Customize Quick Access 
Toolbar button.

 2. Near the bottom of the Customize Quick Access Toolbar menu, click More 
Commands.

 3. In the toolbar commands list, click the command you want to remove. Then between 
the two command lists, click Remove.

 4. At the bottom of the Customize page, click OK.

 10 Securing and Sharing Information

To assign a password to a database

 1. Start  Access 2007.

 2. Click the Microsoft Offi ce Button, and then on the menu, click Open.

 3. In the Open dialog box, navigate to the folder where the database is located, and 
click the database to select it. Then click the Open arrow, and in the list, click Open 
Exclusive.

 4. On the Database Tools tab, in the Database Tools group, click the Encrypt with 
Password button.

 5. In the Password box of the Set Database Password dialog box, type a password, 
and then press the D key.

 6. In the Verify box, type the same password you typed in the Password box. Then 
click OK.

To test a database password

 1. Open  the database.

 2. In the Enter database password box of the Password Required dialog box, type an 
incorrect password, and then click OK.
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 3. In the Microsoft Offi ce Access message box warning you that the password you 
entered is not valid, click OK. 

 4. In the Password Required dialog box, type the correct password, and then click OK.

To remove a password from a database

 1. Start  Access 2007.

 2. Click the Microsoft Offi ce Button, and then on the menu, click Open.

 3. In the Open dialog box, navigate to the folder where the database is located, and 
click the database to select it. Then click the Open arrow, and in the list, click Open 
Exclusive.

 4. On the Database Tools tab, in the Database Tools group, click the Decrypt 
Database button.

 5. In the Password box of the Unset Database Password dialog box, type the current 
password, and then click OK.

To secure VBA code in a database by using a password

 1. Open   a database, and on the Database Tools tab, in the Macro group, click the 
Visual Basic button.

 2. On the Tools menu of the Visual Basic Editor, click Base Properties.

 3. On the Protection tab of the Project Properties dialog box, select the Lock project 
for viewing check box.

 4. In the Password box, type a password, and then press the D key.

 5. In the Confi rm Password box, type the same password you entered in the 
Password box, and then click OK.

 6. Close the Visual Basic Editor, and then close the database.

To test a VBA-securing password

 1. Open  the database.

 2. On the Database Tools tab, in the Macro group, click the Visual Basic button (or 
press J+~).

 3. Click the Expand button to the left of the database project.

 4. In the Password dialog box, type the password for the database, and then click OK.
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To remove the security from the VBA code in a database

 1. On   the Visual Basic Editor Tools menu, click Base Properties.

 2. On the Protection tab, clear the Lock project for viewing check box, and delete 
the asterisks from the two password boxes. Then click OK.

To secure a database by saving it as a distributable ACCDE fi le

 1. Open   a database, and on the Database Tools tab, in the Database Tools group, 
click the Make ACCDE button.

 2. In the Save As dialog box, navigate to the folder you want to save the fi le in, and 
then click Save.

To split a database:

 1. Make a copy of the database on your computer, and then open it.

 2. On the Database Tools tab, in the Move Data group, click the Access Database 
button.

 3. In the Database Splitter wizard, click Split Database.

 4. In the Create Back-end Database dialog box, specify a name and storage location 
for the back-end database, click Split, and then click OK in the message box telling 
you that the split was successful.
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Chapter at a Glance  1	 Exploring	
	 	 Access	2007

In this chapter, you will learn to:

	 ✔	 Work in Access 2007.

	 ✔	 Understand database concepts.

	 ✔	 Open an existing database.

	 ✔	 Explore tables, queries, forms, reports, and other Access objects.

	 ✔	 Preview and print Access objects.

Microsoft Offi ce Access 2007 is part of the 2007 Microsoft Offi ce system, so the basic 
interface objects—such as the Offi ce menu, the Quick Access Toolbar, the Ribbon, and 
dialog boxes—will be familiar if you have used other Offi ce 2007 products. However, 
Access has more dimensions than most of those other products or programs, so it 
might seem more complex until you become familiar with it.

If you are upgrading from an earlier version of Access, then you should review “Introducing 
Access 2007” in the front of this book to learn about differences between earlier versions 
and Access 2007.

In this chapter, you will learn to work in the Access program window and learn about the 
concepts and structure of data storage in Access, including types of databases, types of 
Access objects, and relationships between objects. You will experiment with a complete 
working database, learning about interesting features of Access as well as functionality 
that you will explore in more depth in later chapters.

See Also	 Do	you	need	only	a	quick	refresher	on	the	topics	in	this	chapter?	See	the	Quick	
Reference	section	at	the	beginning	of	this	book.

Important Before you can use the practice fi les in this chapter, you need to install them 
from the book’s companion CD to their default location. See “Using the Companion CD” at 
the beginning of this book for more information.
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Troubleshooting Graphics and operating system–related instructions in this book 
refl ect the Windows Vista user interface. If your computer is running Windows XP 
and you experience trouble following the instructions as written, please refer to the 
“Information for Readers Running Windows XP” section at the beginning of this book.

Working in Access 2007
When you create or open a database, it opens in a database window. The  new Access 
database window interface is designed to more closely refl ect the way people generally 
work with a database or database object. 

Ribbon

Navigation Pane Document window

Microsoft Office Button
Quick Access Toolbar Title bar

The interface includes the following elements:

	 l	 Commands related to managing databases (such as creating, saving, printing, 
backing up, and publishing) are available from the menu that appears when 
you click the  Microsoft Offi ce Button in the upper-left corner of the program 
window. This menu, which we refer to throughout this book as the  Offi ce menu, 
takes the place of the File menu that appeared in pre-vious versions of Access.

	 l	 Some commands are represented by buttons on the  Quick Access Toolbar to the 
right of the Microsoft Offi ce Button. By default, the database window Quick Access 
Toolbar displays the Save, Undo, and Redo buttons.  You can add commands to the 

Troubleshooting Graphics and operating system–related instructions in this book Graphics and operating system–related instructions in this book 
refl ect the Windows Vista user interface. If your computer is running Windows XP refl ect the Windows Vista user interface. If your computer is running Windows XP 
and you experience trouble following the instructions as written, please refer to the and you experience trouble following the instructions as written, please refer to the 
“Information for Readers Running Windows XP” section at the beginning of this book.“Information for Readers Running Windows XP” section at the beginning of this book.



Quick Access Toolbar so that they are available regardless of which tab or object is 
currently active in the database window.

See Also  For information about customizing the Quick Access Toolbar commands 
and location, see “Making Favorite Access Commands Quickly Available” in Chapter 9, 
“Making Your Database Easy to Use.”

	 l	 The title bar displays the name of the active database object (if it is maximized). 
At the right end of the title bar are the three familiar buttons that have the same 
function in all Windows programs. You can temporarily hide the Access window by 
clicking the Minimize button, adjust the size of the window by clicking the Restore 
Down/Maximize button, and close the active window or exit Access by clicking the 
Close button.

	 l	 Below the title bar is the Ribbon, a new feature in many of the programs in the 
Office system. Commands are presented on the Ribbon rather than on the more-
traditional menus or toolbars so that you can work most efficiently within the win-
dow. The Ribbon is organized into task-specific tabs, which are further divided into 
feature-specific or task-specific groups of commands.

	 l	 The buttons in each group change size depending on the width of the program 
window. They might be large, small, or wide, and might be labeled with the button 
name, icon, or both. Pointing to any button displays the button name in a ScreenTip 
that sometimes also describes the button’s function.

Some buttons have arrows, but not all arrows function the same way. If you point 
to a button that has an arrow is incorporated into the button body, clicking the 
button will display a list of options for you to choose from. If the arrow is separate 
from the button body, clicking the arrow will display a list of options and clicking 
the button will perform the currently selected action.

	 l	 Related but less common commands are not represented in a group as buttons. 
Instead they are available from a dialog box, which you can display by clicking the 
Dialog Box Launcher at the right end of the group title bar.

	 l	 The Microsoft Office Access Help button appears at the right end of the Ribbon.

	 l	 The Navigation Pane displays filtered lists of database objects. You can change the 
objects included in the list by clicking the list header and then clicking the category 
or group of objects you want to display.

The goal of the redesigned environment is to make working within an item window 
more intuitive. Commands for tasks you perform often are no longer hidden on menus 
and in dialog boxes, and features that you might not have discovered before are now 
plainly visible.

Dialog Box 
Launcher

Dialog Box 
Launcher

	 Working in Access 2007    �
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By default, Access 2007 displays database objects as   tabbed documents in the document 
window. If you prefer to display each object in a separate window rather than on a sepa-
rate tab, you can do so by clicking Access Options on the Offi ce menu, and then on the 
Current Database page, selecting the   Overlapping Windows option. 

When displaying Tabbed Documents, a Close button for the active database object 
appears to the right of the document tabs. When displaying Overlapping Windows, in 
a maximized database object window, the Minimize, Maximize/Restore Down, and Close 
buttons for the object window appear on the right end of the Ribbon, and the Access 
icon appears to the left of the Home tab. Clicking the Access icon opens the control 
menu , displaying a list of commands related to managing the active object window: 
Restore, Move, Size, Minimize, Maximize, and Close. When not maximized, clicking the 
object icon at the left end of the object window title bar displays the control menu.

In this exercise, you will take a tour of the command structure in an Access 2007 
database window.

USE the Working database. This practice fi le is located in the Documents\Microsoft Press\
Access2007SBS\Exploring folder.

 1. On the Start menu, click Documents. Then in your Documents folder, browse 
to the Microsoft Press\Access2007SBS\Exploring subfolder, and double-click the 
Working database.

The database opens, with the Navigation Pane displaying the All Access Objects 
list. In the   database window, the Ribbon includes four tabs:

	 l	 Home

	 l	 Create

	 l	 External Data

	 l	 Database Tools

Tip Depending on what programs are installed on your computer, tabs and groups 
other than those described here might also appear on the Ribbon.

USE the the WorkingWorking database. This practice fi le is located in the  database. This practice fi le is located in the Documents\Microsoft Press\Documents\Microsoft Press\
Access2007SBS\ExploringAccess2007SBS\Exploring folder. folder.



The Home tab is active by default. Because no database object is currently open, 
only a few buttons on the Home tab are available.

	 2.	 In the upper-left corner of the database window, click the Microsoft Office Button.

The Office menu opens.

You can create a database, but not a database object, from this menu. We’ll  
talk about the commands available from the Office menu in other chapters of  
this book.

	 3.	 Click away from the Office menu to close it.

	 4.	 In the Navigation Pane, under Tables, double-click Categories.

The Categories table opens, an associated Table Tools contextual tab (Datasheet) 
appears, and more of the Home tab becomes active. 

Microsoft Office 
Button

Microsoft Office 
Button
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GroupsAccess Ribbon tabs Contextual tab

Buttons representing commands related to working with database content are 
organized on this tab in seven groups:

	 l	 Views

	 l	 Clipboard

	 l	 Font

	 l	 Rich Text

	 l	 Records

	 l	 Sort & Filter

	 l	 Find

Only the buttons for the commands that can be performed on the currently  
selected database object are active.

Important  Depending on your screen resolution and the size of the database 
window, you might see more or fewer buttons in each of the groups, the buttons 
you see might be represented by larger or smaller icons than those shown, or the 
group might be represented by a button that you click to display the group’s com-
mands. Experiment with the size of the database window to understand the effect 
on the appearance of the tabs.



	 5.	 On the Home tab, click the Font Dialog Box Launcher.

The Datasheet Formatting dialog box opens.

You can access certain settings not available from the Font group, such as Cell 
Effect and Border Styles, from this dialog box.

	 6.	 In the Datasheet Formatting dialog box, click Cancel.

	 7.	 Click the Create tab.

Buttons representing commands related to creating database objects are organized 
on this tab in four groups:

	 l	 Tables

	 l	 Forms

	 l	 Reports

	 l	 Other

	 8.	 Double-click the Create tab.

Double-clicking the active tab hides the Ribbon and provides more space for the 
active database object.

Dialog Box 
Launcher

Dialog Box 
Launcher
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	 9.	 Click the External Data tab.

The Ribbon reappears, with the External Data tab active. 

Buttons representing commands related to moving information between a database 
and other sources are organized on this tab in four groups:

	 l	 Import

	 l	 Export

	 l	 Collect Data

	 l	 SharePoint Lists

	 10.	 Click anywhere in the open table.

The Ribbon hides again. When you hide the Ribbon, it remains hidden except when 
active, until you again double-click a tab.

	 11.	 Double-click the Database Tools tab to display the tab and redisplay the Ribbon.



Buttons representing commands related to managing, analyzing, and protecting 
information are organized on this tab in fi ve groups:

	 l	 Macro

	 l	 Show/Hide

	 l	 Analyze

	 l	 Move Data

	 l	 Database Tools

CLOSE the Working database.

Understanding Database Concepts
Simple database programs, such as the Database component of Microsoft Works, can 
store information in only one table. These simple databases are often called fl at fi le data-
bases, or just fl at databases.  More   complex database programs, such as Access, can store 
information in multiple related tables, thereby creating what are referred to as relational 
databases. If the information in a relational database is organized correctly, you can treat 
these multiple tables as a single storage area and pull information electronically from dif-
ferent tables in whatever order meets your needs.

A  table is just one of the types of objects that you can work with in Access. Other object 
types include queries, forms, reports, pages, macros, and modules.

Of  all these object types, only one—the table—is used to store information. The rest 
are used to manage, manipulate, analyze, retrieve, display, or publish information stored 
in a table—in other words, to make the information as accessible and therefore as useful 
as possible.

Tip Access   2007 introduces a new file storage format that uses the .accdb extension. 
You can open old Access databases (with an .mdb extension) in Access 2007 and save 
them in the new format, but after they’re converted, you will not be able to open them 
with a previous version of Access.

The new format supports many new features. For more information about this format, 
search Access Help for accdb.

Over the years, Microsoft has put a lot of effort into making Access not only one of the 
most powerful consumer database programs available, but also one of the easiest to 
learn and use. Because  Access is part of the Microsoft Offi ce system, you can use many 

CLOSE the Working database.

	 Understanding	Database	Concepts	 	 9
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of the techniques you know from using other Office programs, such as Microsoft Office 
Word and Microsoft Office Excel, when using Access. For example, you can use familiar 
commands, buttons, and keyboard shortcuts to open and edit the information in Access 
tables. And because Access is integrated with other members of the suite, you can easily 
share information between Access and Word, Excel, or other programs.

In its most basic form, a database is the electronic equivalent of an organized list of 
information. Typically, this information has a common subject or purpose, such as the 
list of employees shown here:

ID Last name First name Title Hire date

1 Anderson Nancy Sales Rep May 1, 2003

2 Carpenter Chase Sales Manager Aug 14, 2001

3 Emanuel Michael Sales Rep Apr 1, 1999

4 Furse Karen Buyer May 3, 2004

This list is arranged in a table of columns and rows. Each column represents a field—a 
specific type of information about an employee: last name, first name, hire date, and so 
on. Each row represents a record—all the information about a specific employee.

If a database did nothing more than store information in a table, it would be no more 
useful than a paper list. But because the database stores information in an electronic 
format, you can manipulate the information in powerful ways to extend its utility.

For example, if you want to locate a person or a business in your city, you can do so  
because the information in the telephone book is organized in an understandable  
manner. If you want to get in touch with someone a little further away, you can go to 
the public library and use its collection of phone books, which probably includes one for 
each major city in the country. However, if you want to find the phone numbers of all 
the people in the country with your last name, or if you want to find the phone number 
of your grandmother’s neighbor, these phone books won’t do you much good because 
they aren’t organized in a way that makes that information easy to find.

When the information published in a phone book is stored in a database, it takes up 
far less space, it costs less to reproduce and distribute, and, if the database is designed 
correctly, the information can be retrieved in many ways. The real power of a database 
isn’t in its ability to store information; it is in your ability to quickly retrieve exactly the 
information you want from the database.

Because you can use standard Web programming code to easily manipulate the infor-
mation in an Access 2007 database, you can create Web sites based on the information 
in your database or share that information with visitors to your site.



Opening an Existing Database
Throughout this book, you will be working with databases that contain information 
about the employees, products, suppliers, and customers of a fictional company. As you 
complete the exercises in this book, you will develop an assortment of queries, forms, 
reports, data access pages, macros, and modules that can be used to enter, edit, and 
manipulate the information in many ways.

When you start Access without opening a database, you see the Getting Started With 
Microsoft Office Access window. You can return to this window at any time by clicking 
the Microsoft Office Button and then clicking New.

From this window you can open a blank database, create a new database from one of  
the many templates supplied with Access, from a template you download from the 
Microsoft Office Online Web site, or from a custom template saved on your computer  
or on a network share. You can also open a database you worked in recently, or navigate 
to any database on your computer and open it.

From the section at the bottom of the Getting Started window, you can link to the 
Microsoft Office Online Web site, where you can find information about all aspects  
of Office and download useful tools.

	 Opening an Existing Database    11
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Enabling Macros and Other Database Content
Some databases, such as those provided for your use in this book, contain 
Microsoft Visual Basic for Applications (VBA) macros that can run code on your 
computer. In most cases, the code is there to perform a database-related task, but 
hackers can also use macros to spread a virus to your computer.

When you open a database containing one or more macros,    if the database is not 
stored in a Trusted Location or signed by a Trusted Publisher, Access displays a 
security warning just below the Ribbon.

While the security warning is displayed, the macros in the database are disabled. 
You can enable macros in three ways:

	 l	 By enabling the macros in the database for use in the current database session.

	 l	 By adding the database publisher to a list of Trusted Publishers. Access will 
automatically enable macro content in any database signed by that publisher.

	 l	 By placing the database in a Trusted Location. Access will automatically enable 
macro content in any database saved in that location. The Trusted Locations 
you specify within Access are not also trusted by other Offi ce programs.

To enable macros for the current database session only:

	 1.	 In the Security	Warning area, click Options.

	 2.	 In the Microsoft	Offi	ce	Security	Options dialog box, click Enable	this	content, 
and then click OK.

To add the publisher of a digitally signed database to the Trusted Publishers list:

	 1.	 In the Security	Warning area, click Options.

	 2.	 In the Microsoft	Offi	ce	Security	Options dialog box, click Trust	all	documents	
from	this	publisher, and then click OK.

To add the location of this database to the Trusted Locations list:

	 1.	 In the Microsoft	Offi	ce	Security	Options dialog box, click Open	the	Trust	
Center.

	 2.	 In the page list in the left pane of the Trust	Center, click Trusted	Locations.

	 3.	 On the Trusted	Locations page, click Add	new	location.

	 l		 l	

	 l		 l	

	 l		 l	

Enabling Macros and Other Database Content
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To enable macros for the current database session only:To enable macros for the current database session only:

	 1.		 1.	 In the In the Security	WarningSecurity	Warning area, click  area, click OptionsOptions..

	 2.		 2.	 In the In the Microsoft	Offi	ce	Security	OptionsMicrosoft	Offi	ce	Security	Options dialog box, click  dialog box, click Enable	this	contentEnable	this	content, , 
and then click and then click OKOK..

To add the publisher of a digitally signed database to the Trusted Publishers list:To add the publisher of a digitally signed database to the Trusted Publishers list:

	 1.		 1.	 In the In the Security	WarningSecurity	Warning area, click  area, click OptionsOptions..

	 2.		 2.	 In the In the Microsoft	Offi	ce	Security	OptionsMicrosoft	Offi	ce	Security	Options dialog box, click  dialog box, click Trust	all	documents	Trust	all	documents	
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To add the location of this database to the Trusted Locations list:To add the location of this database to the Trusted Locations list:

	 1.		 1.	 In the In the Microsoft	Offi	ce	Security	OptionsMicrosoft	Offi	ce	Security	Options dialog box, click  dialog box, click Open	the	Trust	Open	the	Trust	
CenterCenter..CenterCenter.CenterCenter

	 2.		 2.	 In the page list in the left pane of the In the page list in the left pane of the Trust	CenterTrust	Center, click , click Trust	CenterTrust	Center, click Trust	CenterTrust	Center Trusted	LocationsTrusted	Locations..

	 3.		 3.	 On the On the Trusted	LocationsTrusted	Locations page, click  page, click Add	new	locationAdd	new	location..

	 l		 l	

	 l		 l	

	 l		 l	

	 l		 l	

	 l		 l	

	 l		 l	



	 4.	 In the Microsoft	Offi	ce	Trusted	Location dialog box, click Browse.

	 5.	 In the Browse dialog box, browse to the folder containing the current 
database, and then click OK.

	 6.	 In the Microsoft	Offi	ce	Trusted	Location dialog box, select the Subfolders	of	
this	location	are	also	trusted check box if you want to do so, and then click 
OK in each of the open dialog boxes.

If you prefer, you can change the way Access handles macros in all databases:

	 1.	 Click the Microsoft	Offi	ce	Button, and then click Access	Options.

	 2.	 On the Trust	Center page of the Access	Options dialog box, click Trust	
Center	Settings.

	 3.	 On the Macro	Settings page of the Trust	Center, select the option for the 
way you want Access to handle macros:

	 l	 Disable	all	macros	without	notifi	cation. If a database contains macros, 
Access disables them and doesn’t display the security warning to give 
you the option of enabling them.

	 l	 Disable	all	macros	with	notifi	cation. Access disables all macros and 
displays the security warning.

	 l	 Disable	all	macros	except	digitally	signed	macros. Access automatically 
enables digitally signed macros.

	 l	 Enable	all	macros. Access enables all macros.

	 4.	 Click OK in the Trust	Center and in the Access	Options dialog box.

In this exercise, you will open a database, explore some of the objects it contains, and 
then close the database.

USE the Opening database. This practice fi le is located in the Documents\Microsoft Press\
Access2007SBS\Exploring folder.

BE SURE TO start your computer, but don’t start Access before starting this exercise.

 1. On    the Start menu, point to All	Programs, click Microsoft	Offi	ce, and then click 
Microsoft	Offi	ce	Access	2007.

The Getting Started With Microsoft Offi ce Access window opens.

 2. In   the Open	Recent	Database list, click More.

	 l		 l	

	 l		 l	

	 l		 l	

	 l		 l	

	 4.		 4.	 In the In the Microsoft	Offi	ce	Trusted	LocationMicrosoft	Offi	ce	Trusted	Location dialog box, click  dialog box, click BrowseBrowse..

	 5.		 5.	 In the In the BrowseBrowse dialog box, browse to the folder containing the current  dialog box, browse to the folder containing the current 
database, and then click database, and then click OKOK..

	 6.		 6.	 In the In the Microsoft	Offi	ce	Trusted	LocationMicrosoft	Offi	ce	Trusted	Location dialog box, select the  dialog box, select the Subfolders	of	Subfolders	of	
this	location	are	also	trustedthis	location	are	also	trusted check box if you want to do so, and then click  check box if you want to do so, and then click 
OKOK in each of the open dialog boxes. in each of the open dialog boxes.OKOK in each of the open dialog boxes.OKOK

If you prefer, you can change the way Access handles macros in all databases:If you prefer, you can change the way Access handles macros in all databases:

	 1.		 1.	 Click the Click the Microsoft	Offi	ce	ButtonMicrosoft	Offi	ce	Button, and then click , and then click Access	OptionsAccess	Options..

	 2.		 2.	 On the On the Trust	CenterTrust	Center page of the  page of the Access	OptionsAccess	Options dialog box, click  dialog box, click Trust	Trust	
Center	SettingsCenter	Settings..

	 3.		 3.	 On the On the Macro	SettingsMacro	Settings page of the  page of the Trust	CenterTrust	Center, select the option for the , select the option for the Trust	CenterTrust	Center, select the option for the Trust	CenterTrust	Center
way you want Access to handle macros:way you want Access to handle macros:

	 l	 Disable	all	macros	without	notifi	cationDisable	all	macros	without	notifi	cation. If a database contains macros, . If a database contains macros, 
Access disables them and doesn’t display the security warning to give Access disables them and doesn’t display the security warning to give 
you the option of enabling them.you the option of enabling them.

	 l	 Disable	all	macros	with	notifi	cationDisable	all	macros	with	notifi	cation. Access disables all macros and . Access disables all macros and 
displays the security warning.displays the security warning.

	 l	 Disable	all	macros	except	digitally	signed	macrosDisable	all	macros	except	digitally	signed	macros. Access automatically . Access automatically 
enables digitally signed macros.enables digitally signed macros.

	 l	 Enable	all	macrosEnable	all	macros. Access enables all macros.. Access enables all macros.

	 4.		 4.	 Click Click OKOK in the  in the OKOK in the OKOK Trust	CenterTrust	Center and in the  and in the Access	OptionsAccess	Options dialog box. dialog box.

	 l		 l	

	 l		 l	

	 l		 l	

	 l		 l	

	 l		 l	

	 l		 l	

	 l		 l	

	 l		 l	

USE the the OpeningOpening database. This practice fi le is located in the  database. This practice fi le is located in the Documents\Microsoft Press\Documents\Microsoft Press\
Access2007SBS\ExploringAccess2007SBS\Exploring folder. folder.

BE SURE TO start your computer, but don’t start Access before starting this exercise.start your computer, but don’t start Access before starting this exercise.
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 3. In the Open dialog box, navigate to your Documents\Microsoft Press\
Access2007SBS\Exploring folder, and then double-click the Opening database.

The  database window opens.

Troubleshooting If this is the fi rst time you’ve run Access, you might see a security 
warning below the Ribbon. Just ignore this warning for the moment, but be sure to 
read the sidebar “Enabling Macros and Other Database Content” to learn about Access 
security options.

The Navigation Pane on the left side of the program window lists the Access database 
objects. You can use the Navigation Pane to group and fi lter these objects in various 
ways.  You can display only one type of object (for example, all tables) by clicking the 
list title bar and then the category or group of objects you want to display.

If      the Navigation Pane is in your way, you can click the Shutter Bar Open/Close 
button  in its upper-right corner, or press F11, to minimize it. To redisplay the 
Navigation Pane, click the Shutter Bar Open/Close button or press F11.

Tip For more information about the Navigation Pane, search Access Help for 
navigation pane and read the topic Guide to the Navigation Pane.

 4. Click the Microsoft	Offi	ce	Button, and then click Close	Database.

When you close a database in this way, you return to the Getting Started window. 

Tip You   can close Access entirely by clicking the Close button in the upper-right corner 
of the window, or by clicking the Microsoft Offi ce Button and then clicking Exit Access.

Exploring Tables
Tables  are the core database objects. Their purpose is to store information. The purpose 
of every other database object is to interact in some manner with one or more tables. An 
Access database can contain thousands of tables, and the number of records each table 
can contain is limited more by the space available on your hard disk than by anything else.

Tip For     detailed information about Access specifi cations, such as the maximum size of a 
database or the maximum number of records in a table, search Access Help for “Access 2007 
specifi cations” (including the quotes).

Troubleshooting If this is the fi rst time you’ve run Access, you might see a security If this is the fi rst time you’ve run Access, you might see a security 
warning below the Ribbon. Just ignore this warning for the moment, but be sure to warning below the Ribbon. Just ignore this warning for the moment, but be sure to 
read the sidebar “Enabling Macros and Other Database Content” to learn about Access read the sidebar “Enabling Macros and Other Database Content” to learn about Access 
security options.security options.

      
Shutter Bar Open/Close

      
Shutter Bar Open/Close



Every Access object has two or more views. For tables, the two most common views are 
Datasheet view, in which you can see and modify the table’s data, and Design view, in 
which you can see and modify the table’s structure. To open a table in Datasheet view, 
either double-click its name in the Navigation Pane, or right-click its name and then click 
Open. To open a table in Design view, right-click its name and then click Design View. 
After an object is open, you can switch between views by clicking one of the View icons 
in the lower-right corner of the program window, or by clicking the View arrow in the 
Views group on the Home tab, and then selecting a view from the list. If you simply click 
the View button Access switches between views in a manner that at times seems logical. 
If the current view is not Design view, it switches to Design view. If you click it again, the 
table switches to Datasheet view. When other database objects are active, clicking the 
View switches between views in a similar manner.

When you view a table in Datasheet view, you see the table’s data in columns (fields) and 
rows (records).

Row

Column

If two tables have one or more fields in common, you can embed the datasheet from 
one table in another. By using an embedded datasheet, called a subdatasheet, you can 
see the information in more than one table at the same time. For example, you might 
want to embed an Orders datasheet in a Customers table so that you can see the orders 
each customer has placed.

In this exercise, you will open existing database tables and explore the table structures in 
different views.
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USE the Tables database. This practice fi le is located in the Documents\Microsoft Press\
Access2007SBS\Exploring folder.

BE SURE TO start Access and display the Getting Started window before beginning this 
exercise.

Tip In this database, the Navigation Pane fi lter has been set to display all Access 
objects, but the Queries, Forms, and Reports object groups are collapsed. You    can 
collapse and expand groups to display only the ones you want, or you can   fi lter the 
database objects by clicking the list header, and then clicking the option you want 
under Filter By Group.

 1. Click the Microsoft	Offi	ce	Button, and then click Open.

 2. In the Open dialog box, browse to the Documents\Microsoft Press\Access2007SBS\
Exploring folder, and double-click the Tables database.

The database opens.

 3. In the Navigation	Pane, double-click Categories.

The Categories table opens in Datasheet view.

This table contains a list of product categories and fi elds such as Category ID, 
Category Name, and Description.

USE the the TablesTables database. This practice fi le is located in the  database. This practice fi le is located in the Documents\Microsoft Press\Documents\Microsoft Press\
Access2007SBS\ExploringAccess2007SBS\Exploring folder. folder.

BE SURE TO start Access and display the Getting Started window before beginning this start Access and display the Getting Started window before beginning this 
exercise.exercise.



Tip  You can open any database object by right-clicking it in the Navigation Pane and 
then clicking the view you want to open it in. Clicking Open opens the object in its 
default Datasheet.

Tip  You can resize a table column by dragging the vertical bar in the header that 
separates it from the column to its right. You can set the width of a column to the 
width of its widest entry by double-clicking the vertical bar.

	 4.	 Maximize the table window if it isn’t already maximized. Then in the datasheet, 
click the Expand button at the left end of the record for the Bulbs category.

The Bulbs category expands to reveal an embedded subdatasheet. Access displays 
the category records from the Categories table and product records from the 
Products table simultaneously.

	 5.	 Click the Collapse button to the left of the Bulbs category to hide the 
subdatasheet.

	 6.	 Click the Close Window button in the upper-right corner of the table, to the 
right of its tab (not the Close button in the upper-right corner of the program 
window) to close the Categories table. If Access prompts you to save changes to 
the table layout, click Yes.

	 7.	 In the Navigation Pane, double-click the Orders table to open it in Datasheet view.

ExpandExpand

CollapseCollapse
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Record navigation bar View toolbar

The record navigation bar at the bottom of the window indicates that this table 
contains 87 records, and that the active record is number 1 of 87.

	 8.	 Move through the table one record at a time by clicking the Next Record button 
several times.

The selection moves down the OrderID field, because that field contains the insertion 
point.

Tip  You can move the selection one record at a time by pressing the Up Arrow or 
Down Arrow key, one screen at a time by pressing the Page Up or Page Down key, or 
to the first or last field in the table by pressing Ctrl+Home or Ctrl+End.

	 9.	 Move directly to record 40 by selecting the current record number in the record 
navigation bar, typing 40, and then pressing F.

	 10.	 In the Navigation Pane, double-click the Products table to open it in Datasheet 
view.

Notice that the table contains 189 records.

Next RecordNext Record



 11. On   the View toolbar, click the Design	View button.

Datasheet view displayed the data stored in the table, whereas Design view displays 
the underlying table structure.

CLOSE the Products and Orders tables without saving your changes, and then close the 
Tables database to return to the Getting Started window.

Design ViewDesign View

CLOSE the Products and Orders tables without saving your changes, and then close the 
Tables database to return to the Getting Started window.
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Exploring Queries
You can locate specifi c information stored in a table, or in multiple tables, by creating a 
query specifying the parameters of the information you want to fi nd. For example, you 
might want to locate all your out-of-state customers who have purchased gloves within the 
last three months. You could fi nd this information by sorting, fi ltering, and cross-referencing 
table data, but that would be a diffi cult and time-consuming task. It is far simpler to create 
a query that returns all records in the Customers table with billing addresses not in your 
state, whose customer IDs map to records that appear in the Transactions table within the 
past quarter and include item IDs that map to records in the Inventory table that are classi-
fi ed as gloves. That might sound complicated, but the process of creating a query to return 
the results described in this example is quite simple.

Running a query (also called querying the database) displays a datasheet containing the 
records that fi t your search criteria. You can use the query results as the basis for further 
analysis, create other Access objects (such as reports) from the results, or export the re-
sults to another format, such as an Excel spreadsheet or a Microsoft SharePoint list.

If you will want to locate records matching the search criteria at any time in the future, 
you can save the query, and run it again from the Queries section of the Navigation Pane. 
Each time you run a query, Access evaluates the records in the specifi ed table (or tables) 
and displays the current subset of records that match the criteria you have defi ned.

Don’t worry if this all sounds a bit complicated at the moment. When you approach 
queries logically, they soon begin to make perfect sense.   You can easily create queries 
by using the Query wizard that is available to help you structure the query, and if you 
create a query that you are likely to run more than once, you can save it. It then becomes 
part of the database and is displayed when you click Queries in the Navigation Pane.

See Also	 For	more	information	about	queries,	see	Chapter	6,	“Locating	Specifi	c	Information.”

In this exercise, you will explore two existing queries.

USE the Queries database. This practice fi le is located in the Documents\Microsoft Press\
Access2007SBS\Exploring folder.

OPEN the Queries database.

 1. In  the Navigation	Pane, click Queries.

The database window displays all the queries that have been saved as part of this 
database.

USE the the QueriesQueries database. This practice fi le is located in the  database. This practice fi le is located in the Documents\Microsoft Press\Documents\Microsoft Press\
Access2007SBS\ExploringAccess2007SBS\Exploring folder. folder.

OPEN the the QueriesQueries database. database.



	 2.	 Right-click the Current Product List query, and then click Object Properties.

Access displays the properties of the Current Product List query, including a descrip-
tion of its purpose. The icon shown on the General tab matches the icon shown 
for this query in the Navigation Pane, and is an indication of the query’s type. The 
query type is also specified in the Properties dialog box: this is a Select Query.

	 3.	 In the Properties dialog box, click Cancel.

	 4.	 Right-click the Products by Category query, and then click Open.

Access processes the query (commonly referred to as running the query) and  
produces a datasheet displaying the results.
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The record navigation bar indicates that 171 records are displayed; the database 
actually contains 189 records. To find out why 18 of the records are missing, you 
need to look at this query in Design view.

	 5.	 On the View toolbar, click the Design View button.

Access displays the query in Design view.

Two boxes in the top part of the query window list the fields in the tables this 
query is designed to work with. The query is formed in the design grid at the 
bottom of the query window. Each column of the grid can refer to one field from 
one of the tables above. Notice that <> Yes (not equal to Yes) has been entered 
in the Criteria row for the Discontinued field. This query finds all the records that 
don’t have a value of Yes in that field (in other words, all the records that have 
not been discontinued).

	 6.	 As an experiment, in the Criteria row of the Discontinued field, replace <> with 
=, and then on the Design contextual tab, in the Results group, click the Run 
button.

Tip  You can also run a query by switching to Datasheet view.

This time, the query finds all the records that have been discontinued.

Design ViewDesign View



The 18 discontinued products account for the difference between the number 
of records in the Products table and the number of records displayed by the 
original query.

CLOSE the Products By Category query without saving your changes, and then close the 
Queries database.

Exploring Forms
Access tables are dense lists of raw information. It will probably be quite simple for you 
to work directly with tables in a database you create for your own use, but might be 
overwhelming for people who don’t know much about databases. To make it easier 
to enter, retrieve, display, and print information, you can design forms through which 
people can interact with your database.

A   form is essentially a window containing controls that either display information to 
people or accept information that people enter.  Access provides a collection of standard 
Windows controls, such as labels, text boxes, option buttons, and check boxes. With a 
little ingenuity, you can create forms that look and work much like the dialog boxes in 
all Windows applications.

CLOSE the Products By Category query without saving your changes, and then close the 
Queries database.
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A form acts as a friendly interface for a table. Through a form, you can display and edit 
the records of the underlying table, or create new records. As  with tables and queries, 
you can display forms in several views.  The three most common views are:

	 l	 Form	view, in which you enter data

	 l	 Datasheet	view, which looks essentially like a table

	 l	 Design	view, in which you work with the elements of the form to refi ne the way it 
looks and works

Most forms link to only one table, but if you want to link to multiple tables from one 
form, you can embed other forms (subforms) within a form (then referred to as the 
main form). The form shown above in Design view includes      label controls containing 
text that appears in the form in Form view, and text box controls that will contain data 
from the underlying table. Although you can create a form from scratch in Design view, 
you will probably use this view most often to refi ne forms you create by using a wizard.

In this exercise, you will explore forms, subforms, and the available form controls.

USE the Forms database. This practice fi le is located in the Documents\Microsoft Press\
Access2007SBS\Exploring folder.

OPEN the Forms database.

 1. In the Navigation	Pane, under Forms, double-click Orders.

The Orders form opens. This form consists of a main form and a subform. The 
main form displays information from the Orders table. The subform, which looks 
like a datasheet in the middle of the main form, displays the information from the 
Order Details table for the current record.

USE the the FormsForms database. This practice fi le is located in the  database. This practice fi le is located in the Documents\Microsoft Press\Documents\Microsoft Press\
Access2007SBS\ExploringAccess2007SBS\Exploring folder. folder.

OPEN the the FormsForms database. database.



	 2.	 In the form window, on the record navigation bar, click the Next Record button a 
few times to display the next few records.

Notice that the subform changes with each click to display the items purchased on 
that order.

	 3.	 Click the Bill To arrow to display a list of all customers who have placed orders. 

This is an example of a list box control. 

	 4.	 In the Navigation Pane, under Forms, double-click Products.

The Products form opens in Form view.

Next RecordNext Record
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The purpose of this form is to edit or create product records.

 5. On the Home tab, in the Views group, click the View arrow, and then in the list, 
click Design	View.

This is the view in which you can add controls to a form.

 6. Note that two Form Design Tools contextual tabs, Design and Arrange, were added 
to the Ribbon when you switched to Design view. Switch to Form view and then 
back to Design view to see this happen.

Contextual tabs are available only when you are working on an object that needs 
the tools on it.

 7. On the Design	contextual tab, point to each of the buttons in the center section of 
the Controls group to display the name of the control in a ScreenTip. You can use 
these controls to assemble custom forms for your database.

CLOSE the Orders and Products forms without saving your changes, and then close the 
Forms database.
CLOSE the Orders and Products forms without saving your changes, and then close the 
Forms database.



Tip To change the level of detail displayed in ScreenTips, click Access Options on the Offi ce 
menu. The ScreenTip Style list at the top of the Popular page displays the detail options: 
Show feature descriptions in ScreenTips, Don’t show feature descriptions in ScreenTips, and 
Don’t show ScreenTips.

Exploring Reports
You can display the information recorded in your tables in nicely formatted, easily 
accessible  reports, either on your computer screen or on paper. A report can include 
items of information selected from multiple tables and queries, values calculated from 
information in the database, and formatting elements such as headers, footers, titles, 
and headings.

You   can look at reports in four views: 

	 l	 Design	View, in which you can manipulate the design of a report in the same way 
that you manipulate a form.

	 l	 Report	View, where you can scroll through the information in the report without 
the page breaks inserted when it is printed.

	 l	 Print	Preview, in which you see your report exactly as it will look when printed.

	 l	 Layout	View, which displays the data in the report (similar to Print Preview) but 
enables you to edit the layout.

In this exercise, you will preview a report as it will appear when printed.

USE the Reports database. This practice fi le is located in the Documents\Microsoft Press\
Access2007SBS\Exploring folder.

OPEN the Reports database.

 1. In   the Navigation	Pane, under Reports, right-click    Customer	Labels, and then click 
Print	Preview.

The Customer Labels report opens. 

 2. Click the preview document to display a larger view of it.

USE the the ReportsReports database. This practice fi le is located in the  database. This practice fi le is located in the Documents\Microsoft Press\Documents\Microsoft Press\
Access2007SBS\ExploringAccess2007SBS\Exploring folder. folder.

OPEN the the ReportsReports database. database.
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Tip  If the report is too small to read in Print Preview, you can adjust the zoom level 
by clicking the Zoom In button or dragging the Zoom slider that appears in the 
lower-right corner of the Print Preview window.

This report prints customer names and addresses in a mailing label format. You are 
looking at it in a view that is much like Print Preview in other Office programs.

Tip  Access provides a wizard that can help you create a mailing label report. You can 
also use the Customers table as a source document for the Word 2007 mail merge 
tool to create labels like these.

	 3.	 In the Navigation Pane, right-click the Sales by Category report, and then click 
Print Preview.

	 4.	 Scroll through a few pages of the multi-page report by clicking the navigation 
buttons at the bottom of the window.



 5. On the View toolbar, click the Design	View button.

Access displays the report in Design view. In this view, the report looks similar to a 
form. The techniques you use to create forms can also be used to create reports.

CLOSE the Customer Labels report and the Sales By Category report without saving your 
changes, and then close the Reports database.

Design ViewDesign View

CLOSE the Customer Labels report and the Sales By Category report without saving your 
changes, and then close the Reports database.
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Exploring Other Access Objects
Tables, queries, forms, and reports are the objects you will use most frequently in Access. 
You can use them to create powerful and useful databases. However, you can also use 
macros and modules to substantially extend the capabilities of Access.

Tip  Previous versions of Access included Data Access Pages. Access 2007 doesn’t include 
these objects. If you are familiar with Data Access Pages and need something like this, you 
can deploy your database to a collaboration site built with Microsoft SharePoint products 
and technologies, and use the tools provided there.

Macros
A macro is a simple program that performs multiple actions. You can use a macro to 
have Access respond to an event such as the click of a button, the opening of a form, or 
the updating of a record. Macros can be particularly useful when you expect that other 
people who are less experienced with Access than you will work in your database. For 
example, you can make routine database actions, such as opening and closing forms 
or printing reports, available as command buttons on switchboards. And by grouping 
together an assortment of menu commands and having users carry them out with the 
click of a button, you can ensure that everyone does things the same way.

Modules
More powerful than macros, modules are Microsoft Visual Basic for Applications (VBA) 
programs. VBA is a high-level programming language developed by Microsoft for the 
purpose of creating Windows programs. A common set of VBA instructions can be used 
with all programs in the Microsoft Office system, and each program has its own set as 
well. Whereas macros can automate four to five dozen actions, VBA includes hundreds 
of commands and can be extended indefinitely with third-party add-ins. You could use 
VBA to carry out tasks that are too complex to be handled with macros, such as opening 
an Excel spreadsheet and retrieving specific information.

Tip  The Microsoft 2007 Office system installation CD and the online resources include a 
variety of sample databases that illustrate many of the principles of creating and using a 
database. You can use these to learn more about Access features, or as templates for your 
own databases. 

One of these, the Northwind 2007 database, is used as an example in many topics in the 
Access Help system, so it is a particularly good database for you to explore. You’ll find a link 
to this database in the Sample category in the Getting Started window.



Previewing and Printing Access Objects
Because  Access is a Windows application, it interacts with your printer through standard 
Windows dialog boxes and drivers. This means that any printer that you can use from 
other programs can be used from Access, and any special features of that printer, such 
as color printing or duplex printing, are available in Access.

As you have seen in this chapter, you can use different Access objects—tables, forms, 
reports, and so on—to display the information stored in your database. Within each 
object there are several views available: Design view, Datasheet view, and so on.  You 
can choose the view you want by selecting it from the View group on the Home tab 
(the views available will depend on the object that is active) or by clicking the buttons 
on the View toolbar at the right end of the status bar at the bottom of the window.

The print-related commands are available from the Microsoft Offi ce Button or on the 
Ribbon when their use would be appropriate, which is determined by the object displayed 
and the current view of that object.

In this exercise, you will preview and print a table and a form.

USE the Print database. This practice fi le is located in the Documents\Microsoft Press\
Access2007SBS\Exploring folder.

OPEN the Print database.

 1. In the Navigation	Pane, expand the Tables list, and then double-click the 
Employees table to open it in Datasheet view.

This table contains information about nine employees. You can see that there are 
more fi elds than will fi t on the screen.

USE the the PrintPrint database. This practice fi le is located in the  database. This practice fi le is located in the PrintPrint database. This practice fi le is located in the PrintPrint Documents\Microsoft Press\Documents\Microsoft Press\
Access2007SBS\ExploringAccess2007SBS\Exploring folder. folder.

OPEN the the PrintPrint database. database.PrintPrint database.PrintPrint
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	 2.	 To display the first page of the datasheet printout, click the Microsoft Office 
Button, point to Print, and then click Print Preview.

	 3.	 Click the preview document once to zoom in, so the table content is legible.

	 4.	 At the bottom of the Print Preview window, click the Next Page button.

This datasheet will print as three short pages if you print it with the current settings. 
Notice that the information on the second and third pages is a continuation of the 
table started on the first page.

	 5.	 On the Print Preview tab, in the Page Layout group, click the Landscape button.

In Landscape orientation, the datasheet fits onto two pages.

Microsoft Office 
Button

Microsoft Office 
Button

Next PageNext Page



Tip  In this book, when we give instructions to implement a command we tell you 
on what tab and in which group the command button appears. When directing you 
to use multiple command buttons on the same tab, we might omit the tab name to 
avoid needless repetition.

	 6.	 In the Print group, click the Print button.

The Print dialog box opens. You can select the printer and set print options (such 
as the range of pages, specific records, or number of copies to be printed) from 
this dialog box.

Tip  If you just want to send this datasheet to your default printer, click the Microsoft 
Office Button, point to Print, and then click Quick Print.

	 7.	 Close the Print dialog box and then in the Close Preview group, click the Close 
Print Preview button.

	 8.	 In the Navigation Pane, under Forms, double-click Employees.

The Employees form opens in Form view.

The information for each employee appears on its own page. Notice that there 
are two tabs at the top of the page, one for company information and one for 
personal information.

	 9.	 Click the Personal Info tab to see the information that is listed there, and then 
return to the Company Info tab.
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 10. Click the Microsoft	Offi	ce	Button, point to Print, and then click Print	Preview to 
preview the printout.

Notice that the preview shows information from only the active form tab. If you 
want to print information that appears on a different tab, you fi rst need to select 
that tab.

 11. On the View toolbar, click the  Form	View button to return to that view.

See Also	 You	use	essentially	the	same	methods	to	print	information	displayed	in	different	
Access	objects.	For	more	information,	see	“Previewing	and	Printing	a	Report”	in	Chapter	8,	
“Working	with	Reports.”

CLOSE the Employees table and the Employees form without saving your changes, and 
then close the Print database.

Form ViewForm View

CLOSE the Employees table and the Employees form without saving your changes, and 
then close the Print database.Print database.Print



Key Points
	 l	 Access is part of the Microsoft Office system, so the basic interface objects—

menus, toolbars, dialog boxes—work much the same as other Office products  
or other Windows applications.

	 l	 A database is the computer equivalent of an organized list of information. The 
power of a database is in your ability to organize and quickly retrieve precise  
information from it, and then to manipulate, share, and distribute or use this infor-
mation in various ways. In Access, data is organized in tables comprised of columns 
and rows, called fields and records. Access is a relational database, so you can treat 
the multiple tables in one database as a single storage area and easily pull informa-
tion from different tables in whatever order and format that suits you.

	 l	 The types of objects you can work with in Access include tables, queries, forms, 
reports, macros, and modules. Tables are the core database objects and the pur-
pose of every other database object is to interact with one or more tables.

	 l	 Every Access object has two or more views. For example, you view data in a table 
in Datasheet view and define how the data is displayed in Design view.

	 l	 One way to locate information in an Access database is to create and run a query. 
You use queries to find information so that you can view, change, or analyze it in 
various ways. You can view queries in Datasheet view or Design view. You can use 
the results of a query as the basis for other Access objects, such as a form or report.

	 l	 Forms make it easy for users to enter, retrieve, display and print information stored 
in tables. A form is essentially a window in which you can place controls that either 
give users information or accept information they enter. Forms can be viewed in 
Form view, Datasheet view, or Design view.

	 l	 Reports display information from your tables in a nicely formatted, easily accessible 
way, either on your computer screen or on paper. A report can include items of infor- 
mation from multiple tables and queries, values calculated from information in the 
database, and formatting elements such as headers, footers, titles, and headings. 
Reports can be viewed in Design view, Print Preview, and Layout Preview.

	 l	 Macros and modules substantially extend the capabilities of Access. Macros 
can be used to make routine database actions available as command buttons 
in forms, which help less experienced users work in your database. Modules are 
VBA programs. Whereas macros can automate many actions, VBA can be used to 
carry out tasks that are too complex to be handled with macros.
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Chapter at a Glance  10	 Securing	and	
	 	 Sharing	Information

In this chapter, you will learn to:

	 ✔	 Assign a password to a database.

	 ✔	 Prevent changes to database code.

	 ✔	 Secure a database for distribution.

The  need for database security is an unfortunate fact of life. As with your house, car, 
offi ce, or briefcase, the level of security required for your database depends on the 
value of what you have and whether you are trying to protect it from curious eyes, 
accidental damage, malicious destruction, or theft.

The security of a company’s business information can be critical to its survival. For 
example, you might not be too concerned if a person gained unauthorized access 
to your products list, but you would be very concerned if a competitor managed to 
see—or worse, steal—your customer list. And it would be a disaster if someone de-
stroyed your critical order information.

Your goal as a database developer is to provide adequate protection without imposing 
unnecessary restrictions on the people who should have access to your database.  The 
type of security required to protect a database depends to a large extent on how many 
people are using it and where it is stored. If your database will never be opened by more 
than one person at a time, you don’t have to worry about the potential for corruption 
caused by several people trying to update the same information at the same time. If your 
database is sold outside of your organization as part of an application, you will want to 
take steps to prevent it from being misused in any way.

Tip In previous versions of Access you could set up workgroups and assign permissions 
to restrict the information available to members of each group and the actions they can 
perform. Access 2007 doesn’t offer this feature.
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Another way to protect a database is by securing the distribution channel; for example, 
by making it available from a password-protected Web site.

In this chapter, you will explore ways to protect data from accidental or intentional 
corruption, and ways to make it diffi cult for unauthorized people to gain access to 
private information. Then you will learn about ways of sharing databases among 
team members and backing up a shared database.

See Also	 Do	you	need	only	a	quick	refresher	on	the	topics	in	this	chapter?	See	the	Quick	
Reference	section	at	the	beginning	of	this	book.

Important Before you can use the practice fi les in this chapter, you need to install them 
from the book’s companion CD to their default location. See “Using the Companion CD” at 
the beginning of this book for more information.

Troubleshooting Graphics and operating system–related instructions in this book 
refl ect the Windows Vista user interface. If your computer is running Windows XP 
and you experience trouble following the instructions as written, please refer to the 
“Information for Readers Running Windows XP” section at the beginning of this book.

Assigning a Password to a Database
You  can prevent unauthorized users from opening a database by assigning it a password. 
Access will prompt anyone attempting to open the database to enter the password. The 
database will open only if the correct password is entered.

Creating a Secure Password
You    can use any word or phrase as a password, but to create a secure password, 
keep the following in mind:

	 l	 Passwords are case-sensitive. 

	 l	 You can include letters, accented characters, numbers, spaces, and most 
punctuation. 

A good password includes uppercase letters, lowercase letters, and symbols or 
numbers, and isn’t a word found in a dictionary. For more information about 
strong passwords, visit 

www.microsoft.com/athome/security/privacy/password.mspx

Troubleshooting Graphics and operating system–related instructions in this book Graphics and operating system–related instructions in this book 
refl ect the Windows Vista user interface. If your computer is running Windows XP refl ect the Windows Vista user interface. If your computer is running Windows XP 
and you experience trouble following the instructions as written, please refer to the and you experience trouble following the instructions as written, please refer to the 
“Information for Readers Running Windows XP” section at the beginning of this book.“Information for Readers Running Windows XP” section at the beginning of this book.

	 l		 l	

	 l		 l	

Creating a Secure Password
YouYou can use any word or phrase as a password, but to create a  can use any word or phrase as a password, but to create a secure password, , secure password, secure passwordsecure password
keep the following in mind:keep the following in mind:

	 l	 Passwords are case-sensitive. Passwords are case-sensitive. 

	 l	 You can include letters, accented characters, numbers, spaces, and most You can include letters, accented characters, numbers, spaces, and most 
punctuation. punctuation. 

A good password includes uppercase letters, lowercase letters, and symbols or A good password includes uppercase letters, lowercase letters, and symbols or 
numbers, and isn’t a word found in a dictionary. For more information about numbers, and isn’t a word found in a dictionary. For more information about 
strong passwords, visit strong passwords, visit 

www.microsoft.com/athome/security/privacy/password.mspxwww.microsoft.com/athome/security/privacy/password.mspx

	 l		 l	

	 l		 l	

	 l		 l	

	 l		 l	



A     secondary benefi t of assigning a password is that your database will automatically 
be encrypted each time you close it, and decrypted when you open it and provide the 
correct password. 

Tip In previous versions of Access, encrypting and decrypting a database was a separate 
function from assigning a password to it. If you open a database created in Access 2002 
or Access 2003 from Access 2007, you will still have the option of encoding or decoding it, 
which is what the process was called in those versions.

It  is easy to assign a database password, and certainly better than providing no protection 
at all, in that it keeps most honest people out of the database. However, many inexpensive 
password recovery utilities are available, theoretically to help people recover a lost pass-
word. Anyone can buy one of these utilities and “recover” the password to your database. 
Also, because the same password works for all users (and nothing prevents one person 
from giving the password to many other people), simple password protection is most 
appropriate for a single-user database.

To   assign a password to or remove a password from a database, you must fi rst open the 
database for exclusive use, meaning that no one else can have the database open. This 
will not be a problem for the database used in the following exercise, but if you want to 
set or remove a password for a real database that is located on a network share, you will 
need to make sure nobody else is using it.

Database Encrypting
A   database created in Microsoft Offi ce Access 2007 is a  binary fi le; if you open it in 
a word processor or a text editor, its content is mostly unreadable. However, if you 
look closely enough at the fi le, you can discover quite a bit of information. It is un-
likely that enough information will be exposed to allow someone to steal anything 
valuable. But if you are concerned that someone might scan your database fi le with a 
utility that looks for key words that will lead them to restricted information, you can 
encrypt the fi le to make it really unreadable.

In previous versions of Access, the process of encoding (encrypting) a database and 
assigning a password were separate. In Access 2007, they have been combined as 
one command.

Encrypting a fi le prevents people who don’t have a copy of Access from being able 
to read and perhaps make sense of the data in your fi le. 

Database Encrypting
A A database created in Microsoft Offi ce Access 2007 is adatabase created in Microsoft Offi ce Access 2007 is a binary fi le;; if you open it in if you open it in 
a word processor or a text editor, its content is mostly unreadable. However, if you a word processor or a text editor, its content is mostly unreadable. However, if you 
look closely enough at the fi le, you can discover quite a bit of information. It is un-look closely enough at the fi le, you can discover quite a bit of information. It is un-
likely that enough information will be exposed to allow someone to steal anything likely that enough information will be exposed to allow someone to steal anything 
valuable. But if you are concerned that someone might scan your database fi le with a valuable. But if you are concerned that someone might scan your database fi le with a 
utility that looks for key words that will lead them to restricted information, you can utility that looks for key words that will lead them to restricted information, you can 
encrypt the fi le to make it really unreadable. the fi le to make it really unreadable.encrypt the fi le to make it really unreadable.encryptencrypt

In previous versions of Access, the process of encoding (encrypting) a database and In previous versions of Access, the process of encoding (encrypting) a database and 
assigning a password were separate. In Access 2007, they have been combined as assigning a password were separate. In Access 2007, they have been combined as 
one command.one command.

Encrypting a fi le prevents people who don’t have a copy of Access from being able Encrypting a fi le prevents people who don’t have a copy of Access from being able 
to read and perhaps make sense of the data in your fi le. to read and perhaps make sense of the data in your fi le. 
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In this exercise, you will assign a password to a database.

USE the Password database. This practice fi le is located in the Documents\Microsoft Press\
Access2007SBS\Securing folder.

BE SURE TO start Access before beginning this exercise, but don’t open the Password 
database yet.

 1. Click  the Microsoft	Offi	ce	Button, and then on the menu, click Open.

 2. In   the Open	dialog box, navigate to the Documents\Microsoft Press\Access2007SBS\
Reports folder, and click (don’t double-click) the Password database. Then click the 
Open arrow, and in the list, click Open	Exclusive.

Access opens the database for your exclusive use—no one else can open the 
database until you close it.

 3. On the Database	Tools tab, in the Database	Tools group, click the  Encrypt	with	
Password button.

The Set Database Password dialog box   opens.

Tip Access 2007 includes many database-management tools. Familiarize yourself 
with the commands available from the Database Tools tab.  From this tab you can, for 
example, display an object’s dependencies, document the entire database, and update 
the linked tables.

 4. In the Password box, type 2007!SbS, and then press the D key.

Access disguises the characters of the password as asterisks as you type them, to 
protect against other people seeing your password.

USE the the PasswordPassword database. This practice fi le is located in the  database. This practice fi le is located in the PasswordPassword database. This practice fi le is located in the PasswordPassword Documents\Microsoft Press\Documents\Microsoft Press\
Access2007SBS\SecuringAccess2007SBS\Securing folder. folder.

BE SURE TO start Access before beginning this exercise, but don’t open the start Access before beginning this exercise, but don’t open the PasswordPassword
database yet.database yet.

Microsoft Offi ce 
Button

Microsoft Offi ce 
Button



 5. In the Verify box, type 2007!SbS. Then click OK.

 6. Close and reopen the database.

The Password Required dialog box   opens.

 7. In the Enter	database	password box, type 2007_SBS, and then click OK.

Access warns you that the password is not valid.

 8. In the Microsoft	Offi	ce	Access message box warning you that the password you 
entered is not valid, click OK. 

 9. In the Password	Required dialog box, type the correct password (2007!SbS), and 
then click OK.

The database opens.

CLOSE the Password database.

Tip To  remove a password from a database, open the database exclusively, entering 
the password when prompted to do so. On the Database Tools tab, in the Database Tools 
group, click the Decrypt Database button . Enter the password, and then click OK. Access 
removes the password, allowing anyone to open the database.

Preventing Changes to Database Code
If     you have added Microsoft Visual Basic for Applications (VBA) procedures to a database, 
you certainly don’t want users who aren’t qualifi ed or authorized to make changes to your 
code. You can prevent unauthorized access in two ways: by protecting your VBA code with 
a password, or by saving the database as a Microsoft Database Executable (ACCDE) fi le  . If 
you set a password for the code, it remains available for editing by anyone who knows the 
password. If you save the database as an ACCDE fi le, people using the database application 
can run your code, but they can’t view or edit it.

See Also	 For	information	about	saving	a	database	as	an	executable	fi	le,	see	“Securing	a	
Database	for	Distribution”	later	in	this	chapter.

CLOSE the Password database.Password database.Password
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In this exercise, you will secure the VBA code in a database by assigning a password to it.

USE the Prevent database. This practice fi le is located in the Documents\Microsoft Press\
Access2007SBS\Securing folder.

BE SURE TO start Access before beginning this exercise.

OPEN the Prevent database.

 1. On the Database	Tools tab, in the Macro group, click the Visual	Basic button.

The Visual Basic Editor   starts.

 2. On the Tools menu, click base	Properties.

The Project Properties dialog box   opens.

 3. On the Protection	tab, select the Lock	project	for	viewing check box.

 4. In the Password box, type 2007!VbA, and then press the D key.

USE the the PreventPrevent database. This practice fi le is located in the  database. This practice fi le is located in the PreventPrevent database. This practice fi le is located in the PreventPrevent Documents\Microsoft Press\Documents\Microsoft Press\
Access2007SBS\SecuringAccess2007SBS\Securing folder. folder.

BE SURE TO start Access before beginning this exercise.start Access before beginning this exercise.

OPEN the the PreventPrevent database. database.PreventPrevent database.PreventPrevent



Access disguises the characters of the password as asterisks as you type them, to 
protect against other people seeing your password.

Tip  The Lock and Password settings operate independently. Selecting the Lock Project 
For Viewing check box requires the user to enter the password to view the project. If 
a password has been set and the Lock Project For Viewing check box is not selected, 
the user can view the project code but has to enter the password to open the Project 
Properties dialog box.

	 5.	 In the Confirm Password box, type 2007!VbA, and then click OK.

The password is set, but you won’t have to enter it again until the next time you 
open the database and attempt to edit the VBA code.

	 6.	 Close the Visual Basic Editor, and then close the database.

	 7.	 Reopen the database, and then on the Database Tools tab, in the Macro group, 
click the Visual Basic button (or press J+~).

The Visual Basic Editor opens, displaying only the name of the project, and not the 
Code window.

	 Preventing Changes to Database Code    279



280 	 Chapter	10	 Securing	and	Sharing	Information

 8. Click the Expand button to the left of the Prevent database project.

The Password dialog box   opens.

 9. In the Password dialog box, type 2007!VbA, and then click OK.

The project expands to display its components.

Tip You need to enter the password only once per database session. In other words, 
you won’t have to enter it again unless you close and reopen the database.

CLOSE the Prevent database.

Tip To    remove the password, on the Visual Basic Editor Tools menu, click Base Properties. 
On the Protection tab, clear the Lock Project For Viewing check box, delete the asterisks 
from the two password boxes, and then click OK.

ExpandExpand

CLOSE the Prevent database.Prevent database.Prevent



Securing a Database for Distribution
When a database is used locally, on a local area network (LAN), or on a wide area  
network (WAN), you have considerable control over who has access to it. But if you 
send the database out into the world, on its own or as part of a larger application,  
you lose that control. There is no way you can know who is using the database or  
what tools they might have available to hack into it. If this is of concern to you, con-
sider distributing your database as an Access Database Executable (ACCDE) file.

Tip  In previous versions of Access this was called a Microsoft Database Executable (MDE) 
file. The functionality and creation process are the same. If you open an older (Access 2002 
or Access 2003) MDB file in Access 2007, a Make MDE command appears in the Database 
Tools group on the Database Tools tab in place of the Make ACCDE command that appears 
when you’re working in an Access 2007 database. 

Suppose you want to make a database available for use by several organizations in the 
area, but the organizations don’t want their members to be able to change the data-
base objects and perhaps “break” things. Saving a database as an ACCDE file compiles 
all modules, removes all editable source code, and compacts the destination database. 
Users of the ACCDE file can view forms and reports, update information, and run queries, 
macros, and VBA code. They cannot do the following:

	 l	 View, edit, or create forms, reports, or modules in Design view.

	 l	 Add, delete, or change references to other objects or databases.

	 l	 Modify VBA code.

	 l	 Import or export forms, reports, or modules.

Access can save a database as an ACCDE file only if it is in Access 2007 format. Access 
2002 and Access 2003 databases can be saved as MDE files.

You can’t convert a database from ACCDE format to the source ACCDB format, so after 
saving a database as an ACCDE file, retain the original ACCDB file in a safe place. If you 
need to make changes to forms, reports, or VBA code, you will have to make them in 
the original database and then save it as an ACCDE again.
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Splitting a Database for Distribution
To help database performance and reliability in a shared implementation, such as 
when multiple people will access a database over a network at the same time, you 
can split the database into two parts: A back-end database containing the tables and 
a front-end database containing the forms, queries, and reports. To split a database:

	 1.	 Make a copy of the database on your computer, and then open it.

	 2.	 On the Database	Tools tab, in the Move	Data group, click the Access	Database 
button. Then in the Database Splitter wizard, click Split	Database.

	 3.	 In the Create	Back-end	Database dialog box, specify a name and storage loca-
tion for the back-end database, click Split, and then click OK in the message 
box telling you that the split was successful.

Distribute the front-end fi le (the one you started with) to the database users. 
It will automatically connect to the back-end fi le (stored in the location you 
specifi ed in step 3).

In this exercise, you will secure a database by saving it as a distributable ACCDE fi le. 

USE the Distribute database. This practice fi le is located in the Documents\Microsoft 
Press\Access2007SBS\Securing folder.

OPEN the Distribute database.

 1. On the Database	Tools tab, in the Database	Tools group, click the  Make	ACCDE 
button.

 2. In the Save	As dialog box, navigate to the Documents\Microsoft Press\
Access2007SBS\Securing folder, and then click Save.

The process takes only a moment; no message alerts you when it is completed.

 3. Click the Microsoft	Offi	ce	Button, and then click Open. 

 4. In the Open dialog box, navigate to the Securing folder.

Access has created a database executable fi le named Distribute.accde. The fi le 
icon displays a blue lock over the standard Access icon.

Tip The Distribute.laccdb fi le indicates that your database is locked, because it is 
currently open. When you close the database, the .laccdb fi le will disappear.

Splitting a Database for Distribution
To help database performance and reliability in a shared implementation, such as To help database performance and reliability in a shared implementation, such as 
when multiple people will access a database over a network at the same time, you when multiple people will access a database over a network at the same time, you 
can split the database into two parts: A back-end database containing the tables and can split the database into two parts: A back-end database containing the tables and 
a front-end database containing the forms, queries, and reports. To split a database:a front-end database containing the forms, queries, and reports. To split a database:

	 1.		 1.	 Make a copy of the database on your computer, and then open it.Make a copy of the database on your computer, and then open it.

	 2.		 2.	 On the On the Database	ToolsDatabase	Tools tab, in the  tab, in the Move	DataMove	Data group, click the  group, click the Access	DatabaseAccess	Database
button. Then in the Database Splitter wizard, click button. Then in the Database Splitter wizard, click Split	DatabaseSplit	Database..

	 3.		 3.	 In the In the Create	Back-end	DatabaseCreate	Back-end	Database dialog box, specify a name and storage loca- dialog box, specify a name and storage loca-
tion for the back-end database, click tion for the back-end database, click SplitSplit, and then click , and then click OKOK in the message  in the message OKOK in the message OKOK
box telling you that the split was successful.box telling you that the split was successful.

Distribute the front-end fi le (the one you started with) to the database users. Distribute the front-end fi le (the one you started with) to the database users. 
It will automatically connect to the back-end fi le (stored in the location you It will automatically connect to the back-end fi le (stored in the location you 
specifi ed in step 3).specifi ed in step 3).

USE the the DistributeDistribute database. This practice fi le is located in the  database. This practice fi le is located in the Documents\Microsoft Documents\Microsoft 
Press\Access2007SBS\SecuringPress\Access2007SBS\Securing folder. folder.

OPEN the the DistributeDistribute database. database.

Microsoft Offi ce 
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Microsoft Offi ce 
Button



 5. Double-click the Distribute database executable fi le, and if the Microsoft	Offi	ce	
Access	Security	Notice message box appears, click Open.

 6. In the Navigation	Pane, right-click one object of each type (table, query, and so on), 
and note whether the Design	View button on the shortcut menu is active.

The Design View button is available for tables, queries, and macros, but unavailable 
for all other object types. This prevents you or another user from making any design 
changes to forms or reports, or changing any VBA code associated with the database. 

CLOSE the Distribute database.

Important When creating an ACCDE fi le from a database with multiple users, fi rst make 
sure that all other users close the database. You will know that someone else has the database 
open if you locate it in Windows Explorer and see a fi le of the same name, with an .laccdb 
(locked Access database) extension. If you open the database anyway, when you attempt to 
create the accde fi le you will be warned that the database is already opened by someone else 
(the username and machine name are provided) and told to try again later.

Collaborating Through SharePoint
If your organization has a Microsoft Offi ce SharePoint Server 2007 collaboration 
site, you can manage data collection and distribution through that site, by making 
your Access database available online, in one of these ways:

	 l	 Migrate a database to a collaboration site. The Move To SharePoint Site 
wizard creates SharePoint lists linked to your database. The linked data can 
be accessed and managed from the collaboration site or from Access.

	 l	 Publish a database to a collaboration site. You can publish your database to 
a SharePoint library, and provide forms, queries, and reports through which 
other people can update or extract information.

After you make the database available to collaboration site users, they can work 
with the information as they would with any other SharePoint list content—online 
or offl ine—but they can also view the content as it would appear in Access, without 
fi rst starting the program.

One benefi t of sharing a database in this way is that permissions are regulated by 
SharePoint rather than set for the individual database. Another is that you can track 
changes made to the data by site users and recover previous versions of informa-
tion, thus safeguarding against lost data in a way that you can’t with Access alone.

Conversely, you can create a database from existing SharePoint lists, and 
integrate workfl ow processes with a database.

CLOSE the Distribute database.

	 l		 l	

	 l		 l	

Collaborating Through SharePoint
If your organization has a Microsoft Offi ce SharePoint Server 2007 collaboration If your organization has a Microsoft Offi ce SharePoint Server 2007 collaboration 
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SharePoint rather than set for the individual database. Another is that you can track SharePoint rather than set for the individual database. Another is that you can track 
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Conversely, you can create a database from existing SharePoint lists, and Conversely, you can create a database from existing SharePoint lists, and 
integrate workfl ow processes with a database.integrate workfl ow processes with a database.
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	 l		 l	

	 l		 l	

	 l		 l	

	 Securing	a	Database	for	Distribution	 	 283



284    Chapter 10  Securing and Sharing Information

Key Points
	 l	 Your goal as a database developer is to adequately protect your database and the 

information it contains, without imposing unnecessary restrictions on the people 
who use it. The type of security required to protect a database depends on how 
many people are using it and where it is stored.

	 l	 You can encrypt a database, which does not prevent it from being opened and 
viewed in Access, but does keep people who don’t have a copy of Access from 
reading or making sense of the data.

	 l	 You can assign a password to your database to prevent unauthorized users  
from opening it. The database is automatically encrypted when you assign it  
a password.

	 l	 If your database contains VBA procedures, you can protect your VBA code 
by assigning it a password, or by saving the database as an Access Database 
Executable (ACCDE) file. If you set a password for the code, it remains available 
for editing by anyone who knows the password. If you save the database as an 
ACCDE file, people using the file can run your code, but they can’t view or edit it.

	 l	 Other members of your organization can input and extract data through  
a SharePoint collaboration site. By making database information available  
through SharePoint, you can regulate permissions, track changes, and manage 
versioning in ways that you can’t within Access.
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Access Options window, 269
action queries. See also append queries; crosstab 

queries; delete queries; make-table queries; 
queries; select queries; update queries

converting select queries to, 204
creating, lvii, 204
defi ned, 179, 285
types of, 161

actions
basic, 124
defi ned, 286
for objects, displaying list of, 125

Add Existing Fields button, 234
Add Group button, 260
add-ins for exporting to PDF/XPS fi les, 89
Add Item button, 260
address books (Outlook), importing from, 74
Advanced Filter Options button, 154, 157
Advanced Filter/Sort command, liv
aggregate functions, 174, 285
Align Left button, 230
Align Text Left button, 230
aligning

form controls, l, 113
report columns, lix
report text, lix, 230

Allow Zero Length fi eld property, 180
Analyze Table wizard, 211
analyzing performance, 211, 213
And operator, 152
append queries, 161, 285. See also action queries; 

crosstab queries; delete queries; make-table 
queries; queries; select queries; update queries

applications, database
defi ned, 285
macros in, 40
specialized commands in, 40
templates for (see templates)
when appropriate, 37

Apply Filter button, liv
arithmetic operators, 285

+ (add), 152
& (concatenate), 152
/ (divide), 152



arithmetic operators (continued)
* (multiply), 152
- (subtract), 152

arrows, button, 3
Attachment data type, 46
AutoFormat dialog box, 117
AutoFormat gallery, 117
AutoFormats

creating, li
creating from forms, 118
form, 117

AutoForms, 129
automated functions. See macros
AutoNumber data type

defi ned, 45
Long Integer setting for, 184

autonumber fi elds, lv
Avg function, 174–75

B
backing up databases, lvii, 210–11
backward compatibility, 57
BE SURE TO paragraphs, xxiv
binary fi les, 275, 285
binding controls together, l, 109
blank databases, 42
blank fi elds, 180
Boolean data type

defi ned, 181, 208
formatting display of, 184
toggling between yes and no, 183

bound controls, l, 285
Browse For A Location button, 42
Build button, 170
built-in functions, 167
buttons, general, 267

arrows on, 3
gray, 6
inactive, 6
margin icons for, xxiv
name bar, 3, 290
option, 288
ScreenTips, displaying, xxxiii
size and shape of, 6
switchboard, lxii

buttons, Quick Access Toolbar
adding, 268
moving, 270
removing, 271

buttons, specifi c
Access (Import group), 55
Add Existing Fields, 234
Add Group, 260
Add Item, 260
Advanced Filter Options, 154, 157
Align Left, 230
Align Text Left, 230
Apply Filter, liv
Browse For A Location, 42
Build, 170
Center, 238
Close, 3, 33
Close Print Preview, 248
Close Switchboard, 255
Combo Box, 122
Control Wizards, 134
Copy, 99
Create E-mail, 64
Database Documenter, 214
Datasheet View, 182
Date & Time, 230, 237
Delete, 208
Descending, 146–47
Design View, 44, 185, 229
Encrypt With Password, 276
Excel (Import group), 58
Export To Excel Spreadsheet, 83
Export To RTF File, 88
Export To Text File, 90
Export To Word, 88
Filter By Form, 155
First Record, 139
Form, 129
Form View, 34
Format Painter, 122
Group & Sort, 231–32
Image, 120
Insert Page Number, 239
Label, 121, 238
Landscape, 32
Line, 232
Make ACCDE, 282
Microsoft Offi ce, 2, 5, 11, 32, 57, 288
Microsoft Offi ce Access Help, xxxiii–xxxiv
Minimize, 3
More, 72, 93
More Forms, 132
Move All, 132, 171
Move Up, 270
Multiply, 168
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New Record, 128
Next Record, 18, 139
Paste, 99–100
Print, 33
Property Update Options, 190
Query Design, 163, 175, 206
Query Wizard, 203
Remove Database Password And 

Encryption, 277
Report Design, 234
Report Wizard, 222
Restore Down/Maximize, 3
Run, 22, 165, 174, 176, 204–05, 209
Save, 48, 182, 236
Selection, 149
SharePoint List, 62, 85
Show Table, 164
Show Table Of Contents, xxxv
Shutter Bar Open/Close, 14
Subform/Subreport, 134, 241
Summary Options, 225
Switchboard Manager, 253
Text Box, 244
Text File, 66

bytes, restricting number fi elds to, 185

C
calculating with queries, 174
calculations

comparison operators, 152
creating, 166, 170, 191–92
defi ned, 286
functions, entering, 167
logical operators in, 152
multiplying, 168
re-labeling, 169

captions in form controls, 112
categories, custom, 259

creating, lxii, 260
default groups in, 260
groups in (see custom groups)
shortcuts, adding, lxii
plus signs next to (see subdatasheets)

CD companion to book
how to use, xxiii
practice fi les on, xxv
resources available on, xxvii

Center button, 238
centering report text, 238
chapter thumb tabs, how to use, xxiii
Choose Builder dialog box, 126
Close button, 3, 33
CLOSE paragraphs, xxiv
Close Print Preview button, 248
Close Switchboard button, 255
closing

Access, 14
databases, xl
document windows, xl
Print Preview, xli, 33, 248
tables, xlii

code, protecting, 277
coding with VBA, 128
collapsing subdatasheets, 17
Collect Data Through E-mail Messages wizard, 64
collecting data through e-mail, 64
Color gallery, 111
colors, 111
columns, table

adding, 48
data types, changing, 46
defi ned, 10
freezing in place, xliii, 51
hiding, xliii, 50
locking into position, 51
moving, liii
names, editing, 47
names, spaces in, 45
as primary keys, 45
renaming, 44
resizing, xliii, 17, 48, 197
restoring after hiding, 50
selecting adjacent, 50
setting width to widest entry, 17
size, setting, 46
sorting together, 147
unhiding, 50
unique identifi ers, 45

Combo Box button, 122
combo boxes, 195

adding to forms, li
defi ned, 285
inserting, 122

comma-delimited text fi les
defi ned, 285
importing, 66
importing from, xlv
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command buttons
defi ned, 285
in switchboards, inserting, 255
in switchboards, On Click property for, 258

command lists, 3
commands

accessing via the Quick Access Toolbar (see 
Quick Access Toolbar)

defi ned, 267
displaying list of, 269

commands, Quick Access Toolbar
adding, 268
moving, 270
removing, 271

Compact And Repair Database utility, 211–12
compacting databases, lvii
companion CD

how to use, xxiii
practice fi les on, xxv
resources available on, xxvii

comparison operators, 285
= (equal to), 152
> (greater than), 152
>= (greater than or equal to), 152
< (less than), 152
<= (less than or equal to), 152
Like, 152
<> (not equal to), 152

conditional formatting, adding to controls, lii, 119
connection speed required for Offi ce 2007, xxix
constants, 152, 285
contacts (Outlook), importing, 75
control captions

adding, li
defi ned, 112
editing, l

control labels, 24
changing, l
deleting, l
inserting, 121
selecting, l
sizing, l, li

control menu, 4
control properties

defi ned, 108, 152, 285
displaying, 110
editing, xlix
setting, l, 244

control source, 108, 285
options, displaying with Expression Builder, 122

Control Wizards button, 134
controls

aligning, l, 113
background properties, l
background style, 111
binding, l, 109
changing grouped, 109
color, 111
combo boxes (see combo boxes)
conditional formatting, adding to, lii, 119
defi ned, 23, 103, 285, 287
deleting, 113
deselecting, 112
font, 109
formatting, xlix, lii
formatting of, copying, 122
graphics, adding, li
grouping, l, 109
label, 24, 103, 121
layout, changing, l
Logo, 120
margins, 114
modifying simultaneously, 233
moving, xlix, li
positioning precisely, 117
Property sheet, opening, 121
record selector, deleting, lii
scroll bars, deleting, lii
selecting, 110
selecting all, 111
selecting multiple, 111
shadow effect, 112
Size Mode property, 121
sizing, li, lii
sizing to fi t, li, lii, 113, 121
space between, inserting, l
standard, 23
text box, 24, 103, 290
theme, 118
types of, 119
unbound, 122, 290
unbound, inserting, 244
undeleting, 243
wizards, adding without, 122

Convert Database Into dialog box, 57
converting databases from previous versions, 57
Copy button, 99
copying

data, to other programs, 97
formatting, 122
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records, 98
SharePoint lists, 60’
table structure to new table, xlii, 42
tables, 202

Count function, 174, 175
Create E-mail button, 64
Create New dialog box, 254
Create tab, 7
cropping in forms, avoiding, 121
crosstab queries, 160, 285. See also action queries; 

append queries; delete queries; make-table 
queries; queries; select queries; update queries

Currency data type, 183
custom categories, 259

creating, lxii, 260
default groups in, 260
groups in (see custom groups)
plus signs next to (see subdatasheets)
shortcuts, adding, lxii

Custom Filter dialog box, 150
custom groups

default, 260
defi ned, 259, 285
hiding, 261
shortcuts to objects, adding, 261
viewing, 261

custom menus, 264
custom toolbars, 264
Customize AutoFormat dialog box, 117
customizing

forms, 131
Quick Access Toolbar, 268

D
data

entering in tables, 44
entering via list (see lookup lists)
exporting (see exporting)
importing (see importing)
reorganizing, 48
summarizing by adding Totals row, lv, 174

data access pages, 30
data formatting in fi elds. See masks
data source, 122. See also forms
data types, 180

Attachment, 46
AutoNumber, 45, 184
Boolean, 208 (see Yes/No data type)

changing, 46, 181
Currency, 183
Date/Time, setting, 183
fi eld size, restricting, 184
for number fi elds, changing, 185
Number, setting, 181
setting, lv
Text, as default, 181
Yes/No (see Yes/No data type)
for ZIP codes, 46

database applications
defi ned, 285
macros in, 40
specialized commands in, 40
templates for (see templates)
when appropriate, 37

Database Documenter button, 214
Database Documenter utility, 211
database objects. See also specifi c object types

defi ned, 124, 288
deleting, xlii
displaying all instances of, 14
events recognized by, 124
export formats available for, viewing, 80
exporting, 79
importing (see importing)
renaming, xlii
shortcuts, creating with custom groups (see 

custom groups)
uses for, 9
views (see views)

database programs, 286. See also databases
database properties, 42, 180, 212
Database Properties dialog box, 212
database records, attaching fi les to, 46
database security, 273. See also passwords

defi ned, 286
designing, 273
warnings, 12

Database Tools tab, 8
database window, 14

defi ned, 286
key combination for displaying, 265
tabs in, 4

databases
as Access Database Executable (ACCDE) fi les, 281
applications as (see database applications)
backing up, lvii, 210–11
blank, 42
closing, xl
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databases (continued)
code, protecting, 277
compacting, lvii, 211–12
complexity of, 9
content, complying with normalization rules, 41
controlling features available in, 262
creating, from templates, 40
creating, manually, 41–42
default folder, 38
documenting, lviii, 214
earlier versions, migrating, xliv
elements in (see database objects)
encoding/decoding, 275
encrypting, 275
entering data in, xlii
fi le extensions, 40
folder for storing, 38
formatting, xxxix
forms (see forms)
importing, 55
importing information to (see importing)
linking data in, 60
locking, 277
migrating from previous versions, 57
multiple, opening, 82
naming, 40
navigation pages (see forms)
non-Access, importing from, 76
objects (see database objects)
opening, xl, xlii, 13
opening for exclusive use, 275–76
opening multiple, 82
overview of, 10
password-protecting (see passwords)
performance, analyzing, lvii
populating, 37
restricting availability in, 262
saving, 42
saving as ACCDE fi les, lxv
saving in previous formats, 57
splitting for distribution, lxv, 282
startup options (see startup options)
structure, creating with templates, 38 (see also 

templates)
tables (see tables)
templates for (see templates)
title, changing, 263
Trusted Locations list, adding to, xxxix
user-created dialog boxes in (see forms)

Datasheet view
defi ned, 286
layout of, 15
moving directly to row in, 18
opening tables in, 15, 48
running queries in, 22

Datasheet View button, 182
datasheets

columns (see columns, table)
displaying, in Print Preview, 32
embedding in other tables (see subdatasheets)
navigating, xli

Date & Time button, 230, 237
date and time

default year, 183
in reports, inserting, lviii, 230, 237
regional settings, changing, 183

Date And Time dialog box, 230, 237
Date/Time data type, 183
date fi lters, 151
dBASE fi les

importing to, 76
importing from, xlvi

decoding databases, 275
Default Database Path dialog box, 38
default template location, 39
Delete button, 208
delete queries, 161. See also action queries; 

append queries; crosstab queries; 
make-table queries; queries; select 
queries; update queries

converting select queries into, 208
creating, lvii, 206
defi ned, 286
preventing accidental use of, 210
relationships and, 209
testing, 208

deleting
adjacent records, 47
database objects, xlii
fi elds from queries, lv, 164
form control labels, l
form controls, 113
form layouts, 112
primary keys, 45
with queries (see delete queries)
Quick Access Toolbar commands, lxiii
record selector control, from forms, lii
records, precautions for, 206
scroll bar controls from forms, lii
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table rows, xliii, 47
tables, xlii, 43
text boxes, from reports, lix

delimited text fi les, 65
defi ned, 286
exporting data as, 92
importing, 66

delimiters, 286
Descending button, 146–47
deselecting

defi ned, 286
form controls, 112

design grid
columns, widening, 169
connecting lines in, 162
defi ned, 286
fi elds, adding, liv, 164
fi elds, copying all to, 165
fi elds, hiding in results datasheet, 162
fi ltering with, 156
related tables in, 162

Design view
displaying queries in, 22
forms, opening in, xli, 108
layout of, 45
opening tables in, 15
switching to, 44

Design View button, 44, 185, 229
dialog boxes

AutoFormat, 117
Choose Builder, 126
Convert Database Into, 57
Create New, 254
creating, in databases (see forms)
Custom Filter, 150
Customize AutoFormat, 117
Database Properties, 212
Date And Time, 230, 237
Default Database Path, 38
Documenter, 214
Edit List Items, 197
Edit Switchboard Item, 255
Encode As, 91
Export, 81
Export XML, 94
Expression Builder, 166
File Open, 55, 58, 66, 72, 76
Grouping Intervals, 224
help for, accessing, xxxiv
HTML Output Options, 96

Icon Browser, 263
Import Objects, 56
Import Specifi cation, 67
Import XML, 70
Navigation Options, 260
New Query, 170
New Style Name, 118
Page Numbers, 239
Password, 280
Password Required, 277
Performance Analyzer, 213
Print, 248
Print Table Defi nition, 215
Project Properties, 278
Row Height, 50
Save As, 45, 47
Save Export Steps, 82
Set Database Password, 276
Show Table, 163, 175, 206
Summary Options, 225
Theme Settings, 118
Unhide Columns, 50
user-created in databases (see forms)
in Windows XP, navigating, xvii

Dialog Box Launcher, 3, 7, 286
digital signatures, 286
disabling form fi elds, 131
displaying reports, 27. See also reports
divider lines, 232
docking, 286
Documenter dialog box, 214
documenting databases, lviii, 214
Documents folder

as default database location, 38
in Windows XP, xv

Does Not Equal fi lters, liii
downloading templates, 39
drop-down lists

allowing users to add items to (see combo 
boxes)

creating, lv, 195
fi ltering selections in, lvi
hiding columns in, lvi
limiting to preset items, 198
multi-column, creating, lvi, 198
restricting entries to, lvi
selecting options in, 197
values in, cycling through, 200

duplicate queries, 160, 286
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E
Edit List Items dialog box, 197
Edit Switchboard Item dialog box, 255
editing

column names, 47
form captions, 112
reports, 227
source of form data, 122
switchboards, 255

e-mail forms, xlv, 64. See also forms
embedded macros, 30. See also modules

in database applications, 40
enabling, xxxix
export formats available for, 79
settings, changing, xl
storage of, 40
trusted nature of, 40
viewing, 256

embedding datasheets in other tables. See 
subdatasheets

empty strings, 180, 286
Encode As dialog box, 91
Encrypt With Password button, 276
encrypting databases, 275, 286
ending. See closing
entering data

via list (see lookup lists)
in tables, 44

environment, 2
events

basic, 124
defi ned, 286
fi ring, 287
for objects, displaying list of, 124–25

Excel
exporting to, xlvii, 82
importing from, xliv, 57–58
pasting data into, 97

Excel button (Import group), 58
exclusive use, 286
exercises in book, system requirements, xxix
exiting. See closing
expanding

Help topics, xxxvi
subdatasheets, 17

Export dialog box, 81
Export Text wizard, 91

Export To Excel Spreadsheet button, 83
Export To RTF File button, 88
Export To Text File button, 90
Export To Word button, 88
Export XML dialog box, 94
exporting data

defi ned, 286–87
to Excel, 82
to PDF/XPS fi les, 89
reminder for, setting, 86
as RTF (Rich Text Format), 87
saving as Outlook task, 86
saving steps for, 86
to SharePoint, 84
as text, with formatting, 90
as text fi le, delimited, 92
to text fi les, 90
to Word, 87
to XML fi les, 93

exporting forms, xlvii
exporting objects, 79
exporting tables, xlvii, 81

to Excel workbooks, xlvii
to formatted text fi les, xlviii
to HTML fi les, xlviii
to SharePoint sites, xlvii
to XML fi les, xlviii

Expression Builder, 170, 191, 287
control source options, displaying in, 122

Expression Builder dialog box, 166
expressions

arithmetic operators, 152, 285 
comparison operators, 152, 285
creating, 166, 170, 191–92
defi ned, 286
functions, entering, 167
inserting for reports, 245
logical operators, 152
multiplying, 168
re-labeling, 169

Extensible Markup Language (XML) fi les
defi ned, 287
exporting data to, 93
exporting tables to, xlviii
importing from, xlvi, 69
schema, 69, 289
tags in, 68
transforms, applying, 70

298  Edit List Items dialog box



F
fi eld properties, liv, 180
fi elds

adding, xliii
adding, by typing in fi rst row, 43
adding, to queries, liv, 164
data format, specifying (see masks)
data in, specifying precisely (see validation 

rules)
data types (see data types)
default, in new tables, 43
defi ned, 287
empty strings, 180
form, 131
formatting of data, specifying (see masks)
joins in, 164
moving all to queries, 207
multivalued, 42
number, rounding in, 186
number, settings for, 184
properties in. See fi eld properties
renaming, xliii
resizing, xlii
selecting, lvi, 193
size, changing, 185
size, restricting, 184
table (see columns, table)
tables, linking to, 196
validation rules (see validation rules)
values in, storing multiple

fi le formats, 9, 40
File menu. See Offi ce menu
fi le names, 40
File Open dialog box, 55, 58, 66, 72, 76
fi les, HTML, 71

attaching to database records, 46
exporting tables to, xlviii
importing from, xlvi
importing to, 72
parsing, 72
structure tags, viewing, 95

fi les, XML
defi ned, 287
exporting data to, 93
exporting tables to, xlviii
importing from, xlvi, 69
schema, 69

tags in, 68
transforms, applying, 70

Filter By Form button, 155
fi ltering, 143

commands, location of, 149
by date, 151
defi ned, 287
with design grid, 156
drop-down lists, selections in, lvi
by forms, liv, 153
lookup lists, selections in, lvi
on multiple criteria, 148, 156
multiple fi elds, liv, 151
Navigation Pane, 16
results, displaying in forms/reports, 151
vs. sorting or queries, 162
syntax, 155
tables, 148

fi lters
date, 151
Does Not Equal, liii
Navigation Pane, changing, 16
removing, liii, 150
results, displaying in forms, 151
results, displaying in reports, 151
saving as queries, liv, 148
text, liii

fi nding. See also fi ltering
templates, 39
text, 202

fi ne-tuning form control placement, 117
fi ring events, 287
First Record button, 139
fi xed-width text fi les

defi ned, 287
ease of importing, 65

fl at databases, 9, 287
folders

adding to trusted locations, 12
default, for saving database fi les, 38

fonts
in forms , 109
in reports, 237

Form button, 129
form control captions

adding, li
defi ned, 112
editing, l
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form control labels, 24
changing, l
deleting, l
inserting, 121
selecting, l
sizing, l, li, lii

form control menu, 4
form control properties

defi ned, 108, 152, 285
displaying, 110
editing, xlix
setting, l, 244

form control source, 108, 285
form controls. See also label controls; text box 

controls
aligning, l, 113
background properties, l
background style, 111
color, 111
combo boxes (see combo boxes)
defi ned, 23, 103, 285, 287
deleting, 113
deselecting, 112
font, 110
formatting, xlix, lii
formatting of, copying, 122
graphics, adding, li
layout, changing, l
Logo, 120
margins, 114
modifying simultaneously, 233
moving, xlix, li
positioning precisely, 117
Property sheet, opening, 121
record selector, deleting, lii
scroll bars, deleting, lii
selecting, 110
selecting all, 111
selecting multiple, 111
shadow effect, 112
Size Mode property, 121
sizing, lii
sizing to fi t, lii, 113, 121
space between, inserting, l
standard, 23
theme, 118
types of, 119
unbound, 122, 290
unbound, inserting, 244
undeleting, 243
wizards, adding without, 122

form properties
displaying, 110
editing multiple, xlix
inheritance of, 108

Form view, 24, 108
Form View button, 34
Format Painter button, 122
formatting

copying, 122
databases, xxxix

forms. See also AutoForms
AutoFormats, 117
AutoFormats, creating, li
AutoFormats, creating from existing 

forms, 118
binding of, 108
captions, editing, 112
columns, sizing to fi t, 138
control properties, xlix
control source, 108, 285
controls (see form controls)
creating, xlix, lii, 105–106, 129
creation of, 104
customizing, 131
data source, editing, 122
defi ned, 103, 287
design, saving, l
Design view, xli, 108
Detail area, expanding, li
displaying, 123
displaying by default, 263
elements, resizing, 115
in e-mail messages, xlv, 64
export formats available for, 79
exporting to RTF documents, xlviii
exporting to Word, 87
fi elds in, 108
fi elds in, hiding, 131
fi lter results, displaying in, 151
fi ltering by, 153
fonts in, 109
Form view, 108
label controls, 24
labels, xlix
layouts, deleting, 112
layouts, pointer shape and, 114
logos, inserting, 120
navigating, xli
for navigation only (see switchboards)
nested (see subforms)
overview of, 23
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pictures, resizing to avoid cropping, 121
PivotTable, 156
pointer shape and, 114
Property sheet, undocking, 110
record selectors, hiding, 124
record source, 108
vs. reports, 220
scroll bars, hiding, 131
sections in, resizing, 119
sections of, 115
Stacked layout, 108
styles for, 117–18
subforms (see subforms)
switchboards (see switchboards)
views for, 24, 108 (see also Datasheet view; 

Design view; Form view)
wizards, creating with, 132

formulas
comparison operators, 152
creating, 166, 170, 191–92
defi ned, 286
functions, entering, 167
logical operators in, 152
multiplying, 168
re-labeling, 169

freezing columns, xliii, 51
functions, 152

aggregate, 174, 285
automated (see macros)
Avg, 175
built-in, 167
calculation, entering, 167
Count, 174, 175
defi ned, 287
expressions, entering, 167
formulas, entering, 167
Max, 174
Min, 174
StDey, 174
Sum, 176, 176, 245
Var, 174

G
galleries

AutoFormat, 117
Color, 111

Get External Data wizard, 55, 66, 69, 72

Getting Started With Microsoft Offi ce Access 
task pane, 11

glossary terms, formatting of, xxiv
graphics on form controls, li
gray buttons, 6
Group & Sort button, 231–32
grouping

controls, l, 109
report data, lix
report information, 224, 232

Grouping Intervals dialog box, 224
grouping levels, 287
groups, 287

H
hard disk requirements for Offi ce 2007, xxviii
headers and footers, 235
height, table row, 49
Help

categories, displaying, xxxv
for dialog boxes, accessing, xxxiv
displaying, xxxiii, 14
on the Internet, xxxvii
ScreenTips and, xxxiii, 289
searching, xxxvi
Table Of Contents, xxxv
topics, displaying, xxxiv
topics, expanding, xxxvi
topics, printing, xxxvi

help
with book/companion CD, xxxiii
with Word (see Help)

hiding
columns, xliii
custom groups, 261
form fi elds, 131
Navigation Pane, 14
record selectors in forms, 124, 131
Ribbon, xxxix
scroll bars in forms, 131
subdatasheets, 17
table columns, 50

Home tab, 5
horizontal lines, lix, 232
HTML fi les, 71

defi ned, 287
exporting tables to, xlviii

 HTML fi les  301



HTML fi les (continued)
importing from, xlvi
importing to, 72
parsing, 72
structure tags, viewing, 95

HTML Output Options dialog box, 96
HTML tags, 71, 287, 290

I
Icon Browser dialog box, 263
ID fi eld, 43
Image button, 120
Import Exchange/Outlook wizard, 74–75
Import HTML wizard, 72
Import Objects dialog box, 56
import operations, saving and running, xlvii, 56
Import Specifi cation dialog box, 67
Import Spreadsheet wizard, 58
Import Text wizard, 66
Import XML dialog box, 70
Important paragraphs, xxiv
ImportError tables, 59
importing, 53–54. See also linking to data

address books, from Outlook, 74
from comma-delimited text fi les, xlv
contacts, from Outlook, 75
databases, 55
data with Table Analyzer Wizard, 57
dBASE fi les, 76
from dBASE fi les, xlvi
errors when, 59
Excel worksheets, 57–58
from Excel worksheets, xliv
HTML fi les, 72
from HTML fi les, xlvi
non-Access databases, 76
Outlook folders, 74
from Outlook folders, xlvi
queries, 54
query results , 55
saving steps for, 56, 75
SharePoint lists, xliv, 60–62
skipping fi elds when, 75
tables, xliv, 54–55
text fi les, 65–66
XML fi les, 70
from XML fi les, xlvi, 69

inactive buttons, 6
inner joins, 164
input masks. See also InputMask property

characters in, 186
creating, 188
defi ned, 288
optional vs. required characters in, 189
for phone numbers, creating, 188
placeholder text in, 190
restricting entry length with, 191
working with, 190

Input Mask wizard, lv, 188
InputMask property, 186. See also input masks
Insert Page Number button, 239
inserting

combo box controls, 122
label controls, 121

installing practice fi les, xxix
interface elements in exercises, formatting 

of, xxiv
intranet, 287

J
joins, inner/outer, 164

K
key combinations, 264

L
Label button, 121, 238
label controls, 24, 103, 121
labeling expressions, 169
labels, form. See controls, form
LAN (local area network), 287
Landscape button, 32
landscape orientation, switching to, 32
layout, saving changes to, 42
Layout view

defi ned, 248
viewing reports in, lxi

Like operator, 152
Line button, 232
lines in reports, lix, 232
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linking to data. See also importing
defi ned, 60, 287
with universal naming convention (UNC) 

paths, 60
lists, lookup

allowing users to add items to (see combo 
boxes)

creating, lv, 195
fi ltering selections in, lvi
hiding columns in, lvi
limiting to preset items, 198
multi-column, creating, lvi, 198
restricting entries to, lvi
selecting options in, 197
values in, cycling through, 200

lists, SharePoint, xliv, 60, 62
local area network (LAN), 287
locking

databases, 277
table columns, 51

logical operators, 152
And, 152
Like, 152
Not, 152
Or, 152

Logo control, 120
lookup lists

allowing users to add items to (see combo boxes)
creating, lv, 195
fi ltering selections in, lvi
hiding columns in, lvi
limiting to preset items, 198
multi-column, creating, lvi, 198
restricting entries to, lvi
selecting options in, 197
values in, cycling through, 200

Lookup wizard
adding, 198
defi ned, 287
starting, 195

M
macros, 30. See also modules

in database applications, 40
defi ned, 287
embedded (see embedded macros)
enabling, xxxix
export formats available for, 79

settings, changing, xl
storage of, 40
Switchboard.closeSB, 256
Trust Center settings, changing, xl
trusted nature of, 40
viewing, 256

mailing label reports, 28
main form, 287
main reports, 233, 288
Make ACCDE button, 282
make-table queries, 161, 288. See also action 

queries; append queries; crosstab queries; 
delete queries; queries; select queries; 
update queries

many-to-many relationships, 288
mapped network drives, 288
margins

in form controls, 114
in reports, changing, 232

masks. See also InputMask property
characters in, 186
creating, 188
defi ned, 288
optional vs. required characters in, 189
for phone numbers, creating, 188
placeholder text in, 190
restricting entry length with, 191
working with, 190

Max function, 174
MDE (Microsoft Database Executable) fi les. See 

ACCDE (Access Database Executable) fi les
memory requirement for Offi ce 2007, xxviii
menus, preventing changes to, 264
Microsoft Knowledge Base, xxxvii
Microsoft Offi ce Access

closing, 14
Help button, xxxiii–xxxiv
integration with other Offi ce programs, 10
objects. See Access objects
portability of skills, 9
size restrictions, viewing, 14
specifi cations, viewing, 14
starting, 13
starting, on Windows XP, xvi
versions of, outdated, updating databases 

from, 57
Microsoft Offi ce Access objects. See also 

specifi c object types
defi ned, 124, 288
displaying all instances of, 14
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Microsoft Offi ce Access objects (continued)
events recognized by, 124
export formats available for, viewing, 80
exporting, 79
importing (see importing)
shortcuts, creating with custom groups (see 

custom groups)
uses for, 9
views (see views)

Microsoft Offi ce Access Help button, 
xxxiii–xxxiv

Microsoft Offi ce Button, 2, 5, 11, 32, 57, 288
Microsoft Offi ce Diagnostics utility, 211
Microsoft Offi ce Excel

exporting to, xlvii, 82
importing from, xliv, 57–58
pasting data into, 97

Microsoft Offi ce Online, 11
Microsoft Offi ce Outlook

contacts, importing, 75
folders, importing from, xlvi, 74
tasks, saving export operations as, 86

Microsoft Offi ce SharePoint Server
exporting data to, 84
import details, saving as a specifi cation, 61
lists, importing, xliv, 60, 62
sites, exporting to, xlvii
valid site addresses, 61

Microsoft Offi ce Word
exporting data to, 87
pasting data into, 97

Microsoft Press Knowledge Base, xxxiii
Microsoft Product Support Services, xxxvii
Microsoft Visual Basic for Applications 

(VBA), 30. See also modules
comments in code, 128
password protecting code, lxiv
removing passwords from, lxv
returning to Access from, 128

migrating databases from previous versions, 
xliv, 57

Min function, 174
Minimize button, 3
minimizing Navigation Pane, 14
modules, 30. See also macros

defi ned, 288
export formats available for, 79

monitor requirement for Offi ce 2007, xxviii
More button, 72, 93
More Forms button, 132
Move All button, 132, 171

Move Up button, 270
multiplication operator, 168
Multiply button, 168
multivalued fi elds, 42
My Documents folder. See Documents folder

N
name bar

buttons on, 3
defi ned, 290

named ranges, 288
naming

databases, 40
expressions, 169
reports, 226
switchboards, 254
table columns, 44
table columns, with spaces, 45

navigating
datasheets, xli
forms, xli
in Print Preview, 248
subforms, 139
Table Of Contents in Help window, xxxv
tables, xl, 18, 43

Navigation Options dialog box, 260
Navigation Pane

fi lter, changing, 16
groups, collapsing/expanding, 16
hiding, 14
minimizing, 14
moving, 14
view, changing, 16

nested forms
adding, lii
creating, lii, 134
defi ned, 289
exporting to Excel, 82
navigating, 139
related fi elds in, 135
selecting, 137

New Query dialog box, 170
New Record button, 128
New Style Name dialog box, 118
Next Record button, 18, 139
normalization rules, complying with, 41
Not operator, 152
null fi elds, 180
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Number data type, 181
number fi elds

bytes, specifying as entry, 185
data types, changing, 185 (see also data types)
Field Size property, setting, lv
rounding in, 186
settings for, 184

numbered steps, formatting conventions used 
in, xxiv

numbers, sorting, 145

O
objects. See also specifi c object types

defi ned, 124, 288
displaying all instances of, 14
events recognized by, 124
export formats available for, viewing, 80
exporting, 79
importing (see importing)
shortcuts, creating with custom groups (see 

custom groups)
uses for, 9
views (see views)

Offi ce 2007, xxviii
Offi ce menu, 2, 5
Offi ce Online Web site, xxxv
On Click property, 258
one-to-many relationships, 288
one-to-one relationships, 288
OnTheCD icon, xxiv
OPEN paragraphs, xxiv
opening

Access, 13
databases, xl, xlii, 13
databases, exclusively, 275–76
databases, multiple, 82
forms, in Design view, 108
Help, 14
switchboards, 257
tables, xxxix
tables, in Datasheet view, 15, 48
tables, in Design view, 15
templates, xli

operating system required for Offi ce 2007, xxix
operators. See also expressions

arithmetic, 152, 285
comparison, 152, 285
logical, 152

option buttons, 288
Or operator, 152
orientation, changing, xli, 32
outer joins, 164
Outlook

contacts, importing, 75
folders, importing from, xlvi, 74
tasks, saving export operations as, 86

overlapping windows, 4

P
page numbers in reports, lx. See also reports
Page Numbers dialog box, 239
page orientation, xli, 32
painting formatting, 122
parameter queries, 160, 288
parsing

defi ned, 288
HTML fi les, 72

Password dialog box, 280
Password Required dialog box, 277
passwords, 274

assigning, lxiii, 276
defi ned, 288
encoding and, 275
for VBA code, lxiv
for VBA code, removing, lxv
for VBA code, testing, lxv
recovering, ease of, 275
removing, lxiv, 277, 280
secure, creating, 274
testing, lxiv
when to use, 275

Paste button, 99–100
Paste Errors table, 98
pasting data from other programs, 97
PDFs, 89
Performance Analyzer dialog box, 213
Performance Analyzer utility, 211
permissions, 288
phone numbers, input masks for, 188
pictures in forms, 121
PivotTable forms, 156
plain text fi les

comma-delimited, importing from, xlv
delimited, 65
delimited, exporting as, 92
exporting as, 90
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plain text fi les (continued)
exporting as, with formatting, 90
fi le extensions for, 66
fi xed-width, 65
formatted, exporting tables to, xlviii
importing, 66
importing, enclosing fi elds in quotation marks, 65

populating databases, 37, 288
Portable Document Format (PDF) fi les, 89
practice fi les, xxv

installing, xxix
in Windows XP, location of, xv

previewing. See also Print Preview
reports, xli, lviii, lxi, 227
subreports, 246
tables, xli

primary keys, 45, 288
Print button, 33
Print dialog box, 248
Print Preview, 247. See also previewing

adjusting magnifi cation in, 28
closing, xli, 33, 248
displaying datasheets in, 32
displaying reports in, 27
navigating in, 248
zooming in, 28, 248

Print Table Defi nition dialog box, 215
printing, 31

changing page orientation when, 32
Help topics, xxxvi
reports, lxi, 248

processor requirement for Offi ce 2007, xxviii
program interface elements in exercises, 

formatting of, xxiv
Project Properties dialog box, 278
properties, 288

Field Size, setting, lv
InputMask, 186
On Click, 258
Size Mode, 121

properties, fi eld, liv
Allow Zero Length, 180
Required, 180

properties, form, 121
database, setting, 212
displaying, 110
editing multiple, xlix
inheritance of, 108

Property Update Options button, 190
protecting databases. See passwords; security
publisher, 288

Q
queries, 160. See also action queries; append 

queries; crosstab queries; delete queries; 
make-table queries; select queries; update 
queries

aggregate functions, 174
append, 161, 285
calculating with, 174
creating, liv, 163, 203
creating, with Query wizard, 170
crosstab, 160, 285
defi ned, 288
design grid (see design grid)
displaying, 20
displaying in Design view, 22
duplicate, 160
export formats available for, 79
fi elds, adding, liv, 164
fi elds, copying all to, 165
vs. fi ltering or sorting, 162
importing, 54
joins and, 164
make-table, 161, 288
parameter, 160
properties, displaying, 21
properties, viewing, xli
results, hiding fi elds in, 173
running, xli, liv, 165, 176, 204
saving, 20, 169
saving fi lters as, liv, 148
table fi elds, moving all to, 207
tables, adding to, liv, 163, 164
type, displaying, 21
unmatched, 160

queries, action
converting select queries to, 204
creating, lvii, 204
defi ned, 179, 285
types of, 161

queries, delete, 161
converting select queries into, 208
creating, lvii, 206
defi ned, 286
preventing accidental use of, 210
relationships and, 209
testing, 208

queries, select, 160
converting into delete queries, 208
converting into action queries, 204
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defi ned, 289
running, 205
View button in, 205

queries, update, 161, 202
creating, lvi, 203
defi ned, 290
View button in, 205

Query Design button, 163, 175, 206
query results, importing, 55
Query wizard, 170–71
Query Wizard button, 203
Quick Access Toolbar, 2, 267

commands, 2
commands, adding, lxii, 268
commands, deleting, lxiii, 271
commands, repositioning, lxiii, 270
customizing, 268
defi ned, 289
Ribbon commands, adding to, lxiii

Quick Launch bar. See Quick Access Toolbar
Quick Reference, how to use, xxiii
quitting. See closing
quotation marks, importing text fi les with, 65

R
RAM requirement for Offi ce 2007, xxviii
record selectors

defi ned, 289
hiding, 124, 131

record source, 289
records

adjacent, working with, 47
copying, 98
database, attaching fi les to, 46
defi ned, 289
deleting, precautions for, 206
deleting, with delete queries (see delete queries)
fi rst, bug when adding, 43
ID values incrementing in fi rst record, 43
primary keys, 45
sorting, from smallest to largest, liii
sorting, from within a form, 147
sorting, in alphabetical order, liii, 146
sorting, in descending order, 146
sorting, on multiple fi elds, 147
unique identifi ers, 45
unsaved, 43

records, table, 10
default height, setting to, 50
deleting, xliii, 47
height, setting to standard, 50
increasing height, 49
navigating, 18
plus signs next to (see subdatasheets)
resizing all, xliii
setting to standard height, xliii

regional settings, 183
relational databases, 9. See also databases

defi ned, 289
design of, 53

relationships, 133
defi ned, 289
delete queries and, 209

Remove Database Password And Encryption 
button, 277

renaming 
database objects, xlii
table columns, 44
tables, xlii, 43

reorganizing tables, 48
replacing text, 202
Report Design button, 234
Report View, 27
Report wizard, lviii

starting, 222
vs. self-created reports, 221

Report Wizard button, 222
reports, 219

aligning text in, lix
blank, starting, 234
centering text in, 238
columns, aligning, lix
controls, modifying multiple simultaneously, 233
controls, moving as group, lix
creating, lviii
creating, from scratch, 233
currency, formatting text as, 245
date and time, inserting, lviii, 230, 237
defi ned, 289
Design view grid, changing, lx
displaying, 27
editing, 227
elements, moving, 229
elements, sizing to fi t, 237
export formats available for, 79
expressions, inserting, 245
fi elds, adding, 222
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reports (continued)
fi lter results, displaying in, 151
font properties, setting, 237
formatting, 229
vs. forms, 220
gridlines, displaying, 235
grouping and sorting data in, lix
grouping information in, 221, 224, 232
groups, adding, 235
headers and footers, 235
horizontal lines, inserting, lix
layout, selecting, 226
in Layout View, lxi
lines, inserting, 232
in mailing label format, creating, 28
main, 233, 288
margins, changing, 232
naming, 226
overview of, 27
page numbers, inserting, lx
previewing, xli, lviii, lxi, 227
printing, lxi, 248
rulers, toggling on and off, 229
saving, lx
sections, changing height of, lviii, lx
selecting, 230
sorting, 225
subreports (see subreports)
tables in, multiple, 223
templates for, 233, 288
text boxes in, lix
text in, aligning, 230
titles, inserting, lx, 237
unbound controls, inserting, 122, 244, 290
views for, 27
width, changing, lix
zooming in, 228

Request A Delivery Receipt command, 270
Required fi eld property, 180
resizing

columns, 197
form sections, 119
rows, to standard height, 50
table columns, 17, 48
table rows, 49

Restore Down/Maximize button, 3
restoring table columns after hiding, 50
restricting data. See masks; validation rules
results, 289
Ribbon, 3

commands, adding to Quick Access Toolbar, lxiii

Create tab, 7
Database Tools tab, 8
defi ned, 289
displaying, xxxix
External Data tab, 8
groups, 6
hiding, xxxix, 7
Home tab, 5

Rich Text Format (RTF) documents
exporting data as, 87
exporting forms to, xlviii

right-aligning form controls, 113
rounding in number fi elds, 186
routine actions, automating. See macros
Row Height dialog box, 50
rows, table, 10

default height, setting to, 50
deleting, xliii, 47
height, setting to standard, 50
increasing height, 49
navigating, 18
plus signs next to (see subdatasheets)
resizing all, xliii
setting to standard height, xliii

RTF (Rich Text Format) documents
exporting data as, 87
exporting forms to, xlviii

rulers, toggling on and off, 229
rules, 191

creating, lvi, 192
defi ned, 290
Expression Builder, creating with, 170, 191, 287
testing, lv, 193
text for, entering, 192

Run button, 22, 165, 174, 176, 204–05, 209
running heads, how to use, xxiii
running 

queries, xli, liv, 22, 165, 176, 204–05
saved import operations, xlvii, 56

S
Save As dialog box, 45, 47
Save button, 48, 182, 236
Save Export Steps dialog box, 82
saving

blank databases, automatically, 42
database fi les, 38
databases, 42
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export operation steps, 86
fi lters as queries, liv, 148
form design, l
import steps, xlvii, 56, 75
older databases, as current version, 57
queries, 20, 169
reports, lx
tables, xlii

schemas, XML, 289. See also XML fi les
screen elements. See Ribbon
screen resolution requirement for Offi ce 2007, 

xxviii
ScreenTips, xxxiii, 289
scripts, transform

applying to XML fi les, 70
defi ned, 290

scroll bars in forms, hiding, 131
searching

Help, xxxvi
with wildcard characters, 148

secure passwords. See also passwords
creating, 274
defi ned, 289

security. See also passwords
defi ned, 286
designing, 273
warnings, 12

See Also paragraphs, xxiv
select queries, 160. See also action queries; append 

queries; crosstab queries; delete queries; 
make-table queries; queries; update queries

converting into action queries, 204
converting into delete queries, 208
defi ned, 289
running, 205
View button in, 205

selecting
columns, adjacent, 50
fi elds, lvi, 193
form control labels, l
form controls, 110–11
records, adjacent, 47
records, criteria for, 152
reports, 230
subforms, 137

Selection button, 149
selectors, 289
Set Database Password dialog box, 276
SharePoint

exporting data to, 84

import details, saving as a specifi cation, 61
lists, importing, xliv, 60, 62
sites, exporting to, xlvii
valid site addresses, 61

SharePoint List button, 62, 85
shortcuts to custom categories, adding, lxii
Show Table button, 164
Show Table dialog box, 163, 175, 206
Show Table Of Contents button, xxxv
Shutter Bar Open/Close button, 14
shutting down. See closing
signing, 289
Size Mode property of form controls, 121
sizing

form control labels, l
form controls, to fi t, lii, 113, 121
form elements, 115

sorting, 143, 145
columns, 147
defi ned, 289
vs. fi ltering or queries, 162
numbers, 145
reports, lix, 225
tables, 144
text, 145

sorting records
in alphabetical order, liii, 146
in descending order, 146
on multiple fi elds, 147
from smallest to largest, liii
from within a form, 147

splitting databases, lxv, 282
spreadsheets, Excel

exporting to, xlvii, 82
importing from, xliv, 57–58
pasting data into, 97

starting
Access, 13
Access, on Windows XP, xvi
Report wizard, 222
Visual Basic Editor, 278

startup options
bypassing, 266
confi guring, 263
customizing, 262
database title, customizing, 263
defi ned, 289
preventing users from bypassing, 266

StDev function, 174
Step by Step series conventions, xxiii
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strong passwords. See also passwords
creating, 274
defi ned, 289

structuring databases with templates, 38. See 
also templates

styles for forms, 117–18
subdatasheets, 15

collapsing, 17
defi ned, 289
expanding, 17
exporting to Excel, 82
hiding, 17
records in, hiding, xl
records in, viewing, xl

Subform/Subreport button, 134, 241
subforms

adding, lii
creating, lii, 134
defi ned, 289
exporting to Excel, 82
navigating, 139
related fi elds in, 135
selecting, 137

subqueries, 162
SubReport wizard, 241
subreports, 239

borders, making transparent, 246
creating, 241
defi ned, 289
dragging to insert, 240
inserting, lx
previewing, 246
selecting, 241

Sum function, 174, 176, 245
summarizing data, by adding Totals row, lv, 174
summarizing information. See reports
Summary Options button, 225
Summary Options dialog box, 225
Switchboard Manager button, 253
Switchboard.closeSB macro, 256
switchboards, 104

buttons, creating, lxii, 255
buttons, On Click property for, 258
code behind, 253
commands, adding to, 255
creating, lxi, 252
creating, with Switchboard Manager, 253
defi ned, 289
editing, 255

naming, 254
opening, 257
pages, adding, lxi

switching views, xli, 15, 19
syntax, 155, 290
system requirements for Offi ce 2007, xxviii

T
tabbed documents, 4, 290
Table Analyzer Wizard, importing data with, 57
table columns

adding, 48
data types, changing, 46
defi ned, 10
freezing in place, xliii, 51
hiding, xliii, 50
locking into position, 51
moving, liii
names, editing, 47
names, spaces in, 45
as primary keys, 45
renaming, 44
resizing, xliii, 17, 48, 197
restoring after hiding, 50
selecting adjacent, 50
setting width to widest entry, 17
size, setting, 46
sorting together, 147
unhiding, 50
unique identifi ers, 45

table of contents, how to use, xxiii
Table Of Contents in Help window, xxxv
table rows, 10

default height, setting to, 50
deleting, xliii, 47
height, setting to standard, 50
increasing height, 49
navigating, 18
plus signs next to (see subdatasheets)
resizing all, xliii
setting to standard height, xliii

tables
arrow icons next to, 60
closing, xlii
columns in (see columns, table)
copying, 202
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copying information between other Offi ce 
programs, xlix

copying structure of to new, xlii, 42
as core database objects, 14
creating, manually, 41–42
creating, with queries, 161, 288
creating, with templates, xlii, 46
default names of, 42
defi ned, 290
deleting, xlii, 43
deleting from queries, lv, 164
display options (see views)
displaying information from (see reports)
embedding datasheets from other tables in (see 

subdatasheets)
Excel icons next to, 60
export formats available for, 79
exporting, xlvii, 81
exporting to Excel workbooks, xlvii
exporting to formatted text fi les, xlviii
exporting to HTML fi les, xlviii
exporting to SharePoint sites, xlvii
exporting to XML fi les, xlviii
fi elds, linking to, 196
fi elds in (see columns, table)
fi ltering, 148
importing, xliv, 54
importing selected fi elds, 55
navigating, xl, 18, 43
Navigation bar, 18
number of records in, viewing, 18
as object types, 9
opening, xxxix
opening, in Datasheet view, 15, 48
opening, in Design view, 15
orientation when printing, changing, xli
previewing, xli
records in. See rows, table
renaming, xlii, 43
reorganizing, 48
reports on. See reports
rows in (see rows, table)
saving, xlii
saving with new name, 45
sorting, 144
summarizing data of, by adding Totals row, lv, 174
templates for (see templates)
validation rules (see validation rules)
viewing information from multiple (see 

subdatasheets)
views (see views)

tabs, 3, 267. See also Ribbon
Create, 7
Database Tools, 8
in database window, 4
defi ned, 290
External Data, 8
Home, 5

tags, HTML, 71, 287, 290. See also HTML fi les
templates, 37–38

benefi ts of, 38
creating databases from, 40
creating tables from, xlii, 46
default save location, 39
defi ned, 290
downloading, 39
fi nding, 39
opening, xli
viewing descriptions of, 39

testing, 281
delete queries, 208
validation rules, 193

text
in reports, aligning, lix
sorting, 145

Text Box button, 244
text box controls, 24, 103, 290
text boxes in reports, lix
text fi elds, lv
Text File button, 66
text fi les

comma-delimited, importing from, xlv
delimited, 65
delimited, exporting as, 92
exporting as, 90
exporting as, with formatting, 90
fi le extensions for, 66
fi xed-width, 65
formatted, exporting tables to, xlviii
importing, 66
importing, enclosing fi elds in quotation marks, 65

Theme Settings dialog box, 118
themes for form controls, 118
thumb tabs in book, how to use, xxiii
Tip paragraphs, xxiv
title bar

buttons on, 3
defi ned, 290

Title button, 237
titles in reports, 237
To Fit button, 113, 121
Toggle Filter button, 149, 150, 153, 155, 158, 202
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toolbars
preventing changes to, 264
primary (see Ribbon)
Quick Access (see Quick Access Toolbar)

Totals button, 175
Totals row, adding, lv, 174
transaction records, 290
transferring data into a database. See importing
transforms

applying to XML fi les, 70
defi ned, 290

triangles on buttons, 3
Trust Center macro settings, changing, xl
Trusted Locations list, adding to, xxxix, 12
Trusted Publishers list, adding to, xxxix
2007 Microsoft Offi ce system, xxviii

U
unbound controls

defi ned, 122, 290
inserting, 244

UNC (universal naming convention) paths
defi ned, 290
linking to data with, 60

undocking, 290
Unhide Columns dialog box, 50
unhiding table columns, 50
universal naming convention (UNC) paths

defi ned, 290
linking to data with, 60

unmatched queries, 160, 290
Unsaved Record icon, 43
Update button, 205
update queries, 161, 202. See also action 

queries; append queries; crosstab queries; 
delete queries; make-table queries; queries; 
select queries

creating, lvi, 203
defi ned, 290
View button in, 205

updating databases from previous versions, 57
Use Access Special keys check box, 264
Use Control Wizards button, 122
USE paragraphs, xxiv
user environment, 2
user input in exercises, formatting of, xxiv

V
validation rules

creating, lvi, 192
defi ned, 290
Expression Builder, creating with, 170, 191, 287
testing, lv, 193
text for, entering, 192

values, storing multiple in a fi eld, 42
Var function, 174
VBA (Microsoft Visual Basic for Applications), 30. 

See also modules
comments in code, 128
password protecting code, lxiv
removing passwords from, lxv
returning to Access from, 128

VBA Project Explorer pane, 127
versions of Access, outdated, updating 

databases from, 57
View button, 15, 47, 123, 137, 247, 205
View toolbar, 44
views, 15. See also Datasheet view; Design view

changing, 15
current, displaying, 247
defi ned, 290
displaying list of, 247
Layout View, 248
Overlapping Windows, 4
selecting, 31
switching, xli, 15, 19, 44
Tabbed Documents, 4

Visual Basic Editor
passwords, removing, 280
starting, 278

W
Web (HTML) fi les, 71

defi ned, 287
exporting tables to, xlviii
importing from, xlvi
importing to, 72
parsing, 72
structure tags, viewing, 95

width, column, 17
wildcard characters, 148, 290
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window elements. See Ribbon
Windows XP

dialog boxes in, navigating, xvii
Documents folder in, xv
practice fi les, location of, xv
starting Access on, xvi

wizards
adding controls without, 122
Analyze Table, 211
Collect Data Through E-mail Messages, 64
creating forms with, 132
Export Text, 91
Get External Data, 55, 66, 69, 72
Import Exchange/Outlook, 74–75
Import HTML, 72
Import Spreadsheet, 58
Import Text, 66
Input Mask, lv, 188
Lookup, 195, 198, 287
Query, 170–71
Report, lviii, 221-22
SubReport, 241
turning off, for form controls, 122

Word
exporting data to, 87
pasting data into, 97

workgroups, 290
worksheets, Excel

defi ned, 290
exporting to, xlvii, 82
importing from, xliv, 57–58
pasting data into, 97

X
XML File button, 69
XML fi les

defi ned, 287
exporting data to, 93
exporting tables to, xlviii
importing from, xlvi, 69
schema, 69
tags in, 68
transforms, applying, 70

XML Paper Specifi cation fi les, 89
XML schemes, 289
XP

dialog boxes in, navigating, xvii
practice fi les, location of, xv

XPS (XML Paper Specifi cation) fi les, 89

Y
Yes/No data type

defi ned, 181, 208
formatting display of, 184
toggling between yes and no, 183

Z
ZIP codes, data type for, 46
zooming

in Print Preview, 28, 248
in reports, 228
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